Oracle Fusion
Cloud SCM

Using Product Development

24A




Oracle Fusion Cloud SCM
Using Product Development

24A

F88806-01

Copyright © 2011, 2023, Oracle and/or its affiliates.
Author: Landis Gwynn, Venkat Karthik, Sabita Rao

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected
by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate,
broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering,
disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report
them to us in writing.

If this is software, software documentation, data (as defined in the Federal Acquisition Regulation), or related documentation that is delivered to the
U.S. Government or anyone licensing it on behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs (including any operating system, integrated software, any programs embedded, installed, or
activated on delivered hardware, and modifications of such programs) and Oracle computer documentation or other Oracle data delivered to or
accessed by U.S. Government end users are "commercial computer software," "commercial computer software documentation,” or "limited rights
data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, reproduction,
duplication, release, display, disclosure, modification, preparation of derivative works, and/or adaptation of i) Oracle programs (including any
operating system, integrated software, any programs embedded, installed, or activated on delivered hardware, and modifications of such programs),
ii) Oracle computer documentation and/or iii) other Oracle data, is subject to the rights and limitations specified in the license contained in the
applicable contract. The terms governing the U.S. Government's use of Oracle cloud services are defined by the applicable contract for such services.
No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for
use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware
in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe
use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle®, Java, and MySQL are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Inside are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks
or registered trademarks of SPARC International, Inc. AMD, Epyc, and the AMD logo are trademarks or registered trademarks of Advanced Micro
Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products, and services from third parties. Oracle
Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and
services unless otherwise set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be responsible
for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services, except as set forth in an applicable
agreement between you and Oracle.



Oracle Fusion Cloud SCM
Using Product Development

Contents

Get Help

1 Develop Products

Overview of Product Development

Overview of Innovation to Commercialization 2
Business Objects and Structures 5
Overview of Product Development Business Objects

Overview of Structures 6
Get Started 7
Information Tiles on Product Development Overview Page 7
Search for Business Objects 8
Reports and Analytics 8
Use the Item Audit Trail 9
Audit Report on Change Orders 9
How to Use Clipboard 9
Use the Clipboard to Paste Items into a Change Order M
Use Tasks Panel to Manage Business Objects 12
Use Reports and Analytics 12
Items and Documents 13
[tems and Documents in Product Development 13
View Item and Document Details 13
Find Attributes on Item Page 18
Take Action on Items and Documents 19
Review Item and Document Changes 21
Lifecycle Phases in Product Development 21
Considerations for Lifecycle Phases and Effective Dates 22
How Item Grade is Calculated 23
Configure Action Links to Items from Reports 24

ORACLE



Oracle Fusion Cloud SCM
Using Product Development

Generate Item Structure Report 25
Considerations for Managing Flexfields in ltems and Change Orders 26
FAQs About Items and Documents 27
Quality Management in Items 31
Overview of Quality Issues and Actions 31
Overview of Problem Reports and Corrective Actions 31
Create Problem Reports and Corrective Actions 32
Access Quality Objects from an Item Structure 33
Secure Access to Quality Issues and Actions 34
Manufacturers and Manufacturer Parts 39
Overview of Manufacturers 39
Create a Manufacturer and Manufacturer Part 39
Search for Manufacturers 40
Considerations for Managing AML 1
Secure Access to Manufacturers 1
Secure Access to Manufacturer Parts 42
Create Manufacturer Part Using Save As 43
Create OTBI Reports for Manufacturers and ltems 44
FAQs About Approved Manufacturers List 44
Structures 47
Overview of Structures 47
Create Structures 47
Create an Item and Build an Item Structure 47
View and Edit Structure Details 49
Key Actions and Features on a Structure Page 52
Replace a Component 52
Track Replacements 55
Add Reference Designators on Items 55
Delete a Component 56
Rules About Item Structures 57
Manage Substitute Components 58
Import an Item Structure 59
FAQs About Structures 60

ORACLE



Oracle Fusion Cloud SCM
Using Product Development

10

8 Change Management 65
Overview of Change Orders and Change Requests 65
Define a Change Order 68
Create a Change Order and Submit it for Approval 69
Manage Change Orders and Change Requests 70
View and Edit Change Details 71
Edit Released Engineering ltems 73
Modify Assignee 74
Take Action on Changes 75
Add or Remove Participants from Future Status 76
Add or Remove Participants in Current Status 76
Cancel Change Lines 77
Move Change Lines 81
Understand Role Expansion in Change Orders 84
Edit Reference Designators on Changes 84
Manage Tasks in Change Orders and Change Requests 85
Secure Access to Changes 86
Impact Analysis in Change Orders 87
Change Order Notifications 88
Publish Change Orders 9
View Published Change Order Reports 92
Use a Change Order to Redline an Item Structure 92
Use a Change Order to Add a Manufacturer Part to an Item 93
How Application Validates Change Assignee 93
How Revision is Calculated for Engineering Change Orders 94
How Item Approval Privilege is Validated at Role Level 94
FAQs About Change Management 95
Affected Objects and Redlines 105
View Affected Objects and Change Operations 105
Redlines in Change Orders 107
Specify Effective Date for Affected Objects 109
Resolve Revision Conflicts 109
FAQs About Affected Objects and Redlines 12
Workflows 13
Workflows in Product Development 13

ORACLE



Oracle Fusion Cloud SCM
Using Product Development

Ll

12

13

14

15

16

Define a Workflow 13
Review the Change Order Workflow 14
Approve or Reject a Workflow 14
Terminate and Restart a Workflow 15
FAQs About Workflows 15
Relationships 17
Relationships in Items and Documents 17
Relationships in Change Orders 18
Relationship Rules for Changes, Problem Reports, and Corrective Actions 19
Attachments 121
Manage Attachments in Items and Change Orders 121
Considerations for Managing Attachments in Items and Change Orders 122
FAQs About Attachments 123
Roll Up Costs 125
Overview of Cost Rollups in Product Development 125
Display Costs in Product Development 125
Business and Validation Rules 126
FAQs About Roll Up Costs 127
Manage Objects from Supplier Portal 129
View Items on Supplier Portal 129
Create Problem Reports and Corrective Actions 129
View Changes on Supplier Portal 131
Submit Change Requests from Supplier Portal 131
Publish Change Orders from Supplier Portal 132
Analyze Objects with OTBI 133
Why Use OTBI Reports 133
Use Predefined OTBI Dashboards for Changes and Items 133
Publish Items for Analysis in OTBI 133
FAQs About OTBI 134
New Item Requests 135
Overview of New Item Requests 135

ORACLE



Oracle Fusion Cloud SCM
Using Product Development

New Item Request Process 135

ORACLE



Oracle Fusion Cloud SCM
Using Product Development

ORACLE



Oracle Fusion Cloud SCM Get Help
Using Product Development

Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Use help icons @ to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support

You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 Develop Products

Overview of Product Development

Product Development tracks the early development phases of products that are going to be designed or built.

Product Development uses business objects named items, documents, manufacturer parts, change orders, and

change requests to build development structures that describe the assembly or product to be manufactured, or the
subassembly. Change orders are used to track changes on an item, document, their structure, or on a manufacturer part
that's associated with an item, with a revision attachment, or with the attributes of an item or document. Here are some
business objects and features in Product Development:

- Items and Documents - Introduce new items or documents to the enterprise, and add information and data to
them with easily defined attributes and characteristics;

- Structures - Gather items (with associated manufacturer parts) and documents into a structure (Bill of
Materials or BOM);

- Change Orders - Manage change orders formally and centrally on items, documents, AML, structures, and
attachments, and analyze the impact of each change;

- Quality Issues and Actions - Quality Actions and Quality Issues from the Quality Management work area can
be carried and processed by change orders in Product Development;

- Searches - Find items, documents, manufacturer parts, manufacturers, and change orders with simple or
advanced searches;

- Lifecycle Phases and Item Grades - Differentiate between items with revision-specific lifecycle phases, and
with calculated item grades that help evaluate for production readiness;

- AML - Manage manufacturer parts with an Approved Manufacturers List (AML) that can be associated with any
item or part;

- Incorporate Pre-production Proposals - Incorporate Concepts or Requirements from Oracle Innovation
Management Cloud applications;

- Connect to other Applications - Connect items, documents, and change orders to Project Tasks; and,

- Hand over to Manufacturing - Hand over items, documents, and structures to manufacturing, and track them
downstream to production and through to commercialization.

Related Topics
- Items and Documents in Product Development

« Overview of Manufacturers

« Overview of Change Orders and Change Requests
« How to Use Clipboard

» Use Tasks Panel to Manage Business Objects
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Overview of Innovation to Commercialization

Product Development's functionality can be broadened by Innovation Management and Product Hub applications. The
enterprise can streamline its end-to-end business processes:

Innovation and Proposals: Innovation Management applications;

Design and early Development: Product Development;

Manufacturing to Commercialization: Product Hub.

Innovation Management

Innovation Management is a suite of Supply Chain Management applications that promotes the abilities of the
enterprise to build suitable products. Innovation Management includes three compatible applications:

Ideas Workspace: supports and simplifies the innovation process to create, aggregate, and review ideas about
potential products.

- Concepts Workspace: supports defining a product in its conceptual phase, building requirements
specifications, concepts, and proposals.

Product Development to Commercialization

The enterprise brings matured concepts, proposals, and requirements specification forward to become products. A
product is designed and developed in Product Development, then handed over to Product Hub to be manufactured and
commercialized:

Product Development supports item and document creation and enrichment, and building items and
documents into structures. A structure is a list of assemblies - of items and manufacturer parts - or a list of
documents, both including the design and prototype of the product.

Using change orders to formally modify items, documents, and structures, the product evolves and moves
through initial development stages to readiness for manufacturing.

Product Development helps users manage Master Organization items and documents, while Product Hub helps
users manage Site items.

Product Hub takes the product through stages of manufacturing to commercial release, including multiple
versions, packaging, and other downstream processes. Product Hub allows the detailing-out of commercial and
operational attributes, and facilitates the management of part catalogs.

Integrations

Product Development integrates with Innovation Management to help streamline product innovation, design, and
development processes, and with Oracle Project Portfolio Management to manage development projects.

You can also create integrations with your Computer-Aided Design (CAD) applications to enable items, bills of material
and change orders to be managed in Product Development, while continuing to manage CAD designs and data in an
on-premise CAD product data management application.
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To support CAD integration, web services for Changes, Items and Structures are available. You can use these services
to develop integrations between Product Development and Agile Engineering Collaboration, other on-premise CAD
product data management applications, or cloud-based CAD applications.

Related Topics
« Overview of Product Development
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2 Business Objects and Structures

Overview of Product Development Business Objects

You can manage the design and development of products by using the following building blocks:

ltems

Documents

Manufacturer parts and their manufacturers
« Structures and

- Change orders and change requests

ltems and Documents

You can create items in Product Development or Product Information Management work areas to represent the parts
and assemblies of a product. A document is another type of item or part, representing description or specification of
items. The specific attributes of each new business object describe the characteristics of the item or document and,
taken together, the particular product. In this way, item and document business objects carry the necessary technical
and engineering information of the product.

Manufacturer Parts and Manufacturers

A manufacturer part is an item produced by a manufacturer. A manufacturer part can be related to any item designed
or produced by your company.

You can add the approved manufacturers list (AML) on an item’s AML tab. You can also add AML on the Structure
tab of the item. A document may not be associated with a manufacturer part. An item which is associated with a
manufacturer part and belongs to a structure will have an icon next to it on the Structure table that indicates the
association with a manufacturer part.

Manufacturer parts are identified with manufacturer part numbers. Product Development requires a manufacturer to
be created before you may even create a manufacturer part produced by that manufacturer.

Note: Item grade is calculated for items only, not for documents nor for manufacturer parts. However, the
configuration of item grade may allow the AML situation to be considered in the calculation of the item grade.

Change Orders and Change Requests

Change orders and change requests enable you to manage the modifications to an item in your company's design and
manufacturing processes.

When a change order is used to formalize the enrichment of an item (adding and modifying item attributes) or the
construction of a structure, no further modification on any scale can be effected without an additional change order.
Change orders, like items, can be initiated in the Product Development or Product Information Management work areas.
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Related Topics
« Overview of Manufacturers

« Overview of Structures

- Items and Documents in Product Development

« What's the difference between an engineering change order and change request?
« Overview of Change Orders and Change Requests

Overview of Structures

In Product Development, a Bill of Materials is called a structure.

When you add an item to a parent item, you create a simple structure. As items are added, the structure is always
named and referred to by its top-level item.

A structure holds all the items and documents that make up an assembly or subassembly. tems and documents may be
in the same structure; there's no restriction on the maximum or minimum number of either type of business object.

Any item on a structure may be associated with one or more manufacturer parts. On the Structure table, an icon next
to an item indicates the presence of manufacturer parts. So, a structure populated with items will likely comprise
associated manufacturer parts.

A document structure holds all the documents that make up a meaningful document, such as a specification for a
product. When you add a document to a parent document, a simple structure is created. A structure of documents will
be named and referred to by its top-level document. A document structure may be only one document.
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5 Get Started

Information Tiles on Product Development Overview
Page

The information tiles organize information about the business objects in Product Development. They help you find
additional data on favorite items, change orders, and notifications approaching deadlines.

To expand an information tile, click the down arrow icon in the tile. You can then select from, and drill into the
information in that tile.

My Favorite Iltems Information Tile

This information tile organizes items and structures that you've marked as a favorite.

The categories in the tile - Released, Unreleased, and Obsolete - can be similar or parallel with lifecycle phases that are
used by your company. The administrator associates these categories with a lifecycle phase type used in your company.
For example, your administrator can configure the design and the prototype lifecycle phases as unreleased. When you
click each category, you see the items that are currently in the lifecycle phase associated with that category.

My Worklist Information Tile

This information tile filters and collects your notifications about tasks that you must act on. Click each category to see
your notifications in that category. Or click the down arrow icon (View My Worklist) to see your entire worklist.

You can filter the notifications to view either pending or all notifications, and also perform actions on notifications. For
example, you may be notified to review a change order, and you can approve or reject the change order from here.
Actions that aren't available on a selected notification are disabled.

The calculations for the Worklist are based on the Need-by Date attribute.

- Overdue Deadline: The Need-by Date has already passed.
- Approaching Deadline: The Need-by Date is less than 2 days away.

- Waiting for Review: The Need-by Date is in 3 days or more, or not specified.
You can select the Pending option to see the changes that you must act on.

Note: The commercial change orders display the approve, and reject buttons. The approval type column isn't
populated for new item requests, and it doesn’t have the approve or reject buttons.

My Changes Information Tile

This information tile compiles the number of change orders that you created.

- Open link shows all change orders in Draft or Open status;
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Pending Approval link shows all change orders in Interim Approval or Approval status, which means changes
are yet to be approved or rejected;

- Approved link shows all change orders that have been approved, and are therefore ready to be Scheduled or
Completed.

To view change orders, click the View My Changes bar (or the down arrow icon). The My Changes page appears. You can
use the My Changes page to perform the following:

- Create, edit, or delete change orders and change requests.
- Sort change orders based on date, number, and description.
Filter change orders based on type, status, cycle time, date when the change was created, and so on.

Related Topics
- Lifecycle Phases in Product Development

« Overview of Change Orders and Change Requests
- Take Action on Changes
« Use Tasks Panel to Manage Business Objects

Search for Business Objects

In the Product Development work area, you can search for the following business objects: items, documents, change
orders, change requests, manufacturer parts, and manufacturers. You can also perform an advanced search using
operators such as Starts with, Equals, or Contains.

Search for Multiple Items or Documents

You can search for multiple items in the same search operation. Before you use this feature, you must deploy extensible
flexfields.

In the Advanced Search region of the Manage Items page, use the search operator In to search for a list of comma-
separated item numbers.

You can copy and paste values from documents, spreadsheets, or reports into the search field. Comma-separated, tab-
separated, or new line separated lists are supported, and the text box allows up to 1000 characters including commas.

Related Topics
« How to Use Clipboard

« Choose Parameters for Task-Based Item Search
» Deploy Item Flexfields

Reports and Analytics

You can use Reports and Analytics in the panel drawer to create reports and analytics about business objects.
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Quickly view or run analytics and reports that are related to your work in the Reports and Analytics pane. With the
required privileges, you can also create and edit analytics and reports here.

Use the Item Audit Trail

An audit report is the history of an item, a listing of all actions or modifications that have been made on the item.

Because the audit trail could show a complete history across all items, it's necessary to filter first for the data you need.
Your search for items or documents can be restricted by Date, User, Product, Event Type, Business Object Type, and
Description.

To use the audit trail, do the following:

1. Use Navigator to go to the Product Management work area. From the list of offerings, click Product
Development.
2. From the Tasks panel tab, click View Item Audit Trail.

3. On the Audit Reports page, enter the search criteria, including Date, User, and product information, Event
Type, Business Object Type, and Description. Also select whether you want to include child objects.

4. C(lick the Search button.
Review the history in the search results page. To export the search results to a spreadsheet, click the Export

icon.

Related Topics
« Watch Video: Use the Item Audit Trail

Audit Report on Change Orders

To create an audit report on a change order, open a change order, select Actions > Audit and select a status. Then open
the Audit Results side tab and check the results.

The report checks for consistency in the item structure, when the change order holding the structure is moving to
the Approval status. These consistency checks ensure that child items are in the same or higher lifecycle phase as the
parent item; and an Approved parent item doesn't refer to a child item that's still in Draft.

The audit results either show a "no error or warning" message, or show a list of errors and warnings.

How to Use Clipboard

You can copy items and documents to the clipboard and paste them on to other items and documents or affected
objects of a change order.
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Clipboard

Copy items and documents from the Favorites and Recent Items tabs available on the clipboard to speed up your work.
Use the clipboard icon that appears on the Affected Objects tab and Relationships tab to copy items to the clipboard.

The clipboard contains:

- Clipboard: a cumulative list of multiple copied items. The most recently copied item appears at the beginning
(top) of the list. The contents of the clipboard are now retained when you sign out of the application and sign
backin.

Favorites: a list of items that have been specified as favorites by clicking the Add to Favorites (star) icon in the
item header. Click the Refresh icon to display recently added favorites; the most recently added one appears at
the start (top) of the list.

Recent Items: a list of items that you've visited. Click the Refresh icon to display recently visited items. The
most recently visited item appears at the beginning (top) of the list.

Note: The use of the clipboard is subject to security controls. If you've privileges only to search for and view items,
then you can copy and paste the items but not edit them. If you don't have privileges to search for and view items,
then you can't copy the items, and they don't appear on the clipboard.

You can quickly create a structure by using an item on the clipboard. Here's how the Copy and Paste actions work with
the clipboard:

In the source structure, select items or documents and use the Copy icon, or Actions > Copy. The items appear
on the clipboard.

- Open the destination structure and click Clipboard on the side panel.
Review the item (or structure) you want to copy.

- Select the items and drag (move) or use the Paste icon or Actions > Paste.

The following functionality is available when you opt in to the Retain Copied Data on Clipboard feature. It is applicable to
change orders, change requests, problem reports, and corrective actions:

- The clipboard retains its content when you sign out of the application and sign back in.

- The clipboard can hold up to 500 items and you can sort the items by the date you added them, from latest to
oldest.

- Select one or multiple items from the clipboard and use the drag and drop (select and move) or paste icon to
add them to the Affected Objects tab, Item Structure tab, or Relationships tab.

« The selections you make on the clipboard are deselected when you:
o add more items to the clipboard.

o sign out and sign back in.

Points to Remember:

Note that you must first copy the items to the clipboard, select them from the clipboard, and paste them to the
Affected Objects tab or Item Structure tab.

- When you copy the items from the search results table to the clipboard, the items in the clipboard are
deselected.

10
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- When you select items on the clipboard and move either to the Favorites or Recent Items tabs and return to the
clipboard, the selection persists.

The contents of the clipboard aren't cleared out when you sign out. To remove items from the clipboard, you can select
a single item or several items and click Remove (the X icon). Click Clear All to clear the clipboard.

Pages Where You Can Copy and Paste Items

Here are the pages from which you can copy items and structures:

- Change Order > Impact analysis
Item > Item grade
Item > Where Used

Here are the pages on which you can paste items with the clipboard function:

[tem > Structure table

Document > Structure table
- Change Order > Affected Object > Structure table
- Change Order > Affected Object table

Copy Items from Product Development to Quality Management

Once you copy items into the clipboard in the Product Development work area, they also appear on the clipboard in the
Quality Management work area. So you can copy items and paste them directly into the tables of Affected Objects or
Related Objects in:

« Quality issues
- Quality actions

I Note: To access this feature, you must also have the Quality Analyst (ORA_ENQ_QUALITY_ANALYST_JOB) role.

Use the Clipboard to Paste Items into a Change Order

You can use the clipboard to copy and paste items to a change order's affected objects table.

1. Navigate to the Product Development work area.

2. Open an item and click the Structure tab.

3. Select the row that you want to copy.

4. Create a change order in which you want to paste the item.

o From the Tasks panel drawer, click Create Change Orders.
o From the Change Type list, select the type of change order.
o Inthe Name field, enter a name for the change order.

o Inthe Description field, enter a brief description.

n
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o Click Save.

5. Paste the items into the change order.

o Inthe change order, click the Affected Objects side tab.
o Click the Paste icon to paste the item you copied in a previous step.

Similarly, Copy icons in the Change-Impact Analysis and the Item-Grade tabs, enable you to select and copy multiple
items into the clipboard. The Copy icon in the Item-Where Used tab lets you copy only a single row. Selecting a row or
multiple rows activates the icon and a description of the item appears when you hover over it in the clipboard.

Related Topics
« Watch Video: Use the Clipboard

Use Tasks Panel to Manage Business Objects

You can use the Tasks side tab to create and manage business objects even when you're preforming another task on the
interface.

Let's say that you're building a structure and you realize that your structure needs an item that doesn't exist. Then you
use tasks side tab to create a new item and add that to the structure. You can add information to any object as you
create it; or, you can save it in simple form and add more data later.

Related Topics
« View Item and Document Details

» Overview of Change Orders and Change Requests

« Overview of Manufacturers

Use Reports and Analytics

To create reports and analytics about business objects, click the Reports and Analytics panel tab.

If you have permissions, you can create and edit analytics and reports. You can also add reports and analytics from the
Business Intelligence catalog.

To navigate to the Reports and Analytics work area, click Navigator > Tools > Reports and Analytics.
Use the work area to perform an analysis. For example, in a table or graph you can use analyses to:

- Summarize or break down simple, real-time data.

Make short-term decisions.

Related Topics
« Creating and Administering Analytics and Reports for SCM

12
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4 Items and Documents

ltems and Documents in Product Development

ltems and documents have many features in common. Both types of business objects are derived from the same
original class type. From the primary Root Item Class, the administrator may create a Root Document Class.

Additional class types may be created based on the root classes. Different class types allow different kinds of items and
documents. Items created from the same item class inherit the same template of attributes. Documents created from
the same document class inherit the same template of attributes.

The document business object behaves in much the same way as the item business object. A document that contains
information or specification about an item or assembly can be added to an item structure. Or, a document structure
could be built with documents that contain item requirements or specifications in parallel with every item of an item
structure.

The differences between items and documents are:

- Documents can't be associated with manufacturer parts;

- Documents don't use the item grade function and attributes.

Related Topics
« View Item and Document Details

« Overview of New Item Requests

View Item and Document Details

An item's General Information side tab is the starting point to access its basic information. Depending on configuration
and company needs, the attributes of an item might number a dozen or go well beyond a hundred.

Here are the side tabs available on items and documents:

Note:
- A blueicon indicating the presence of content appears on the side tab. Additionally, when you hover on the tab,
the tooltip displays Has Content.

- Blueicons aren't displayed for those tabs that always have content, or have content calculated upon selecting
the tab: General Information, History, and Iltem Grade.

- General Information - the default or cover page of an item or document.

You can view an item's revision number and the corresponding change order from the Revision list on any item
page. The current effective revision is marked with an asterisk (*) character.
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Note:
o Canceled item and document revisions don't appear in the Revision list.

o Previously effective revisions of the item can't be edited.

- Attachments - text or graphic files, or URL, with more information about the item or document; attachments
can be classified in a category. Includes revision-specific content.

- Structure - the Bill of Materials for assembilies, products, and other collections of items and documents.
Includes revision-specific content.

- Quality - displays those quality issues or quality actions to which this item or document has been added.
Includes revision-specific content.

- Changes - lists change orders or change requests that the item or document is on.

- Relationships - user-set association between any two business objects or structures. Includes revision-specific
content.

- Team - users and groups who have access to the item or document.
- Where Used - displays those item-structures to which this item is added.
- History — shows data changes made to audit-enabled item attributes.
Here are the side tabs that are only available on items:
- AML - Approved Manufacturers List; manufacturer parts supplied by approved manufacturers are associated
with items to be added to structures. Includes revision-specific content.
- Item Grade - notifies conditions of risk for the item.

General Information

You can view the fields that are predefined in the application, and the extensible flexfields configured by your
administrator. The administrator can decide whether you can view or edit flexfields by assigning privileges to attribute
groups and users. The flexfields are defined in the item classification; so, available fields are derived from the item class
hierarchy and respective attribute assignments.

You can also add a thumbnail or graphical image of the item.

Here's a description of the key attributes and fields on the general information page:
User Item Type

An attribute that describes the item. For instance, Finished Goods, Freight, or Inventory Type.

Note:

- Redlines to this attribute are seen on the Edit Item page and on the change order in Simplified Change
Management Interface.

- If you create an item in Product Development, you can’t modify User Item Type from Product Information
Management.

- To hide User Item Type in Product Development, use Page Composer.

Unit of Measure
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The Unit of measure attribute is used by a variety of functions and transactions to express the quantity of items. Each
unit of measure you define must belong to a unit of measure class.

The administrator uses the Manage Units of Measure task in the Setup and Maintenance work area to add UOMs to the
list of available UOMs.

You can update the primary unit of measure on a new item request-enabled item when it’s in the Draft status. The
item can be a part of a structure and you can change the UOM to any UOM. If the item is part of a structure or has

a structure, once you change the UOM, save and close the item, a message informs you that the primary UOM was
changed for the item and that this may affect the components in the item structure or any structure where the item is
used. After you update the UOM, you must check and manually update items in any impacted structures.

Note: The primary unit of measure won’t be editable for approved items on new item request classes and non-new
item request classes.

Created From

You can view the Created From attribute on the General Information page where you can see the source item from
which the current item was copied. You can click the source item name to view details and navigate to the source item.
You can also view the details of the Created From attribute in the item history. Here, if the source item is deleted, you
see an ID as the attribute value instead of the item name.

In the Product Development work area:

- the Created From attribute displays the source item name along with the revision.

- when you click the hyperlink, it opens the specific revision of the source item from which the current item was
created.

Irrespective of having access to the item, the hyperlink appears in the Created From field. If you don't have access to the
source item, an error message appears when you click the hyperlink. If the source item is deleted, a message informs
you that no matches were found. If the item wasn’t created using Save As, the attribute value for Created From is blank.

Product Line Attribute
You can use this attribute to assign the item to a product line in your company. This enhances the supply chain's
operational information.

To add product lines, click the plus icon. In the Assign Item to Product Lines dialog box, you can identify which product
line is already assigned to an item. You can also search for a product line and sort the available lines.

Note that the product lines are available for selection here only if your administrator has set up the catalog rules for the
Product Development functional area as described in the topic: Functional Area Catalogs Rules.

Operational Attributes

An enterprise can have hundreds of additional operational attributes for any item or product. These attributes don't
need to be displayed on its main development pages, in fact, they may not become relevant until later on the path to
commercialization. The administrator defines the visibility of operational attributes in Product Development work area.

You can modify the operational attributes from the Product Information Management work area. Here’s how:
Open the item and click the Specifications tab. Operational Attributes appear in tem Organization.
Change-controlled Item Attributes

These attributes can only be modified through a change order.
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Where Used

You can view the other item structures to which the item has been added. You can also use filters to view specific
structures. Note that the following data security privileges are required to view the Where Used report: View Item Basic,
Maintain Item Basic, and View Item Structure or Maintain Item Structure.

Here are the filters and fields on the Where Used tab.

Show Structure Levels: Filter items based on the level in which this item is used in another structure.
- First level: view first level of the structure in which the item is used.
- Top level: view topmost level of the entire bill of material in which the item is used.

- Alllevels: view all levels from the item to the topmost level in which the item is used.

Note that the duplicate components appear only in first and all level views.

Show Items: Filter items based on their approval status in a change order.
- Implemented: view items that are already effective.

- All: view items that are effective and items that are yet to go through the change order approval process.

Filter a large list of items: Use Query by Example. Let's say that you want to filter items by a lifecycle phase.
« Click Query by Example.
- Enter the filter criteria in the field corresponding to Lifecycle Phase.

Date: This is the reference date used when running the where-used query.

Let's say that the date appears as 7/18/19. Then it's the where used data as on 7/18/19. The table shows how the date
differs based on the selected item revision.

Selected Item Revision Date

Past effective Revision end date
Current effective Current date
Pending Current date

Future effective Future effective date

Include Substitute Components
Select this to identify where the item is used as a substitute component. Here are the important columns for substitutes:

- Item: shows the structure in which the item is used as substitute. The number of structure levels shown in the
item depends on what you select in the Show Structure Levels filter.

- Substitute For: Shows the components for which the context item is marked as a substitute. Appears only if
you select First level and Include substitute components filters.
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Here are some additional details on substitute components:
- You can view substitute components only for first level structure in the Ul and all levels in the OTBI report.
- The component number displayed in the Substitute For column is read-only.
When you click the information icon (orange triangle) on the item, a panel that includes links to item entities
appears. Note that you'll only see items for which you’re granted access.

- You can enable substitute component search by default using the profile option Include Substitutes in Item
Where Used Data.

- When you select Include Substitute Components, the Where Used results are restricted to:

the master organization and primary structure in Product Development, and to the context item's organization
in Product Information Management.

- You can perform a search on primary, alternate, or all structures based on the search filters in Product
Information Management.

- The change order details report (in Product Development) includes the following substitute component
attributes: Primary UOM, Enforce Integer Requirement, Priority, and Global descriptive flexfields. The report
doesn't include redlines for substitute components.

Team

At the item class level, your administrator defines users and groups who have access to items and assigns appropriate
privileges.

At the item level, you can use the Team tab to add additional users and groups who should have access to the item.
Note that you can't delete or modify the users and groups defined by the administrator.

History

You can view the history of data changes made to audit-enabled item attributes. Audit data is presented only for the
item that you are currently viewing or editing.

When you click the History tab on an item, you see the changes made in the recent week. You can view data changes
made on the following item tabs: General Information, Structure (excluding reference designators and side tabs), AML
(except for preliminary items), and Security.

You can also search for audit data by a combination of criteria such as user details, the type of data change (add,
update, or delete), a specific field, a specific value in a field, or a specific portion of item data such as extensible
flexfields. Audit-enabled data can include operational attributes of items, item-level extensible flexfields and flexfield
security, item structures, and item structure components. You can also access this data from Navigator > Tools > Audit
Reports.

To see more details in search results, you can select the following:

- Show User-Related Details: Shows the user ID in addition to the user name.

- Show Attribute Details: Shows the actions that were performed on the attribute (created, updated, or deleted),
along with old and new values.

- Show additional object identifier columns: Shows additional columns for Context Name and Context Value,
to indicate each unique context in which the item is used. For instance, if you add a component to the structure,
then the Context Value 2 column shows the component that was added (if the check box is selected).
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Additional information:

- The History tab is available only if your implementor has assigned you the appropriate privileges.

- To view audit data, your audit policy must include the item data attributes that you want to audit. Audit policies
are set up using the Manage Audit Policies task in the Setup and Maintenance work area.

Related Topics
« Overview of Structures

« Why am | unable to view the Substitute For column in the structure details?

- Manage Attachments in Items and Change Orders

« Relationships in Iltems and Documents

» How Item Grade is Calculated

« How Units of Measure, Unit of Measure Classes, and Base Units of Measure Relate to Each Other

Find Attributes on Item Page

You can search for extended flexfield attributes on the item or document page even when the attribute groups are
collapsed. You can also find the next attribute that matches your search criteria.

This is useful when you have to find and edit specific item attributes in items and documents that have a large number
of extended flexfields. You can also choose to keep attribute groups collapsed by default to ensure faster loading of item
and document pages.

Note:

- To keep attribute groups collapsed by default, your administrator must configure the value for the item profile
option ACA_ITEM_EFF_DISPLAY to Collapse All using the Manage Administrator Profile Values task (in the
Setup and Maintenance work area).

- The search doesn't mark up Unit of Measure type attributes in a different color and style.

Here's how you find extended flexfield attributes:

1. Enter the text pattern you're looking for in the Find attributes field on the item or the document page, and click
the Next button.

Note: Pressing Enter won't start the search.

The attribute matching the text pattern appears in a different text color and style for easy identification.
2. To view the next matching attribute, click Next.

The page automatically scrolls to show you the next attribute that matches the text pattern.

If a matching attribute is found within an attribute group that's currently collapsed, the group is expanded to
show you the attribute.

3. To edit the attribute, move the cursor to the attribute field.
4. To navigate through the attribute search results, click the Previous button adjacent to the search field.
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Take Action on Items and Documents

Here are the actions available on items and documents:

Assign to Change Order or Assign to Change Request: quickly assign the item or document to a new change
order or change request.

Save As: create an item or document from the one you're working on.

The primary unit of measure and item attribute values are copied from the item you're working on; you can
modify these values in the Save As dialog box.

The item lifecycle phase is copied from the template defined in the item class. Note that this value is unavailable
in the Save As dialog box.

Delete: mark an item for deletion and add it to a delete group. You can create a new delete group or add the
item to an existing group.

To confirm the item deletion use Manage Delete Group available in the Tasks panel. The item must meet the
deletion constraints so that it's not used in any structure or change order.

In case you want to again use the item and it can't be deleted due to constraints, you must restore the item.
Send Object: send a message about the business object to another user.

Messages displaying the list of recipients can be sent to a single or multiple users. This feature works for items,
documents, and change orders.

Generate Report: generate an item structure report that displays the main attributes of component items as
well as descriptive flexfields and AML. You can configure the attributes that you want to display in the report
template.

Note:
o To generate item structure report, you will require the following roles:

Bl Consumer and

EGO_GENERATE_ITEM_CHANGE_ORDER_REPORT_PRIV_OBI.

o You can generate the report only in Product Development or the Product Information
Management work area and not within Oracle Analytics Publisher. Note that the template is

configured using Oracle Analytics Publisher.
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- Download Attachments: download item and manufacturer part attachments for either first or all structure
levels. You can choose from options and specify which attachments you want to include in your download when
you select Download Attachments from the Actions menu of a change.

If you choose Single level and select Include manufacturer part attachments, then the root item's
attachments including its manufacturer part attachments are downloaded.

If you choose All levels and select Include manufacturer part attachments, then the item and its structure
attachments including manufacturer part attachments at all structure levels are downloaded.

Note:

o You can only download attachments for the manufacturer parts for which you have permission
to access.

o Downloaded attachments appear in Zip files with subfolders showing the item structure
hierarchy. You can find manufacturer part attachments in the AML subfolder.

- View Reports: view the configured Oracle Transactional Business Intelligence (OTBI) reports for the item.

You can search for specific reports or view the configured reports. You can also view specific context options
such as Structures, Where Used, AML, and more.

- Publish for Analysis: publish the structure and where used data for analysis in Oracle Transactional Business
Intelligence (OTBI).

To publish data for analysis, click Actions > View Reports > Publish.

Note: Ensure that all users who need to publish data for analysis have the View Product Management
Reports (ACA_VIEW_PRODUCT_MANAGEMENT_REPORTS_PRIV) privilege to view reports. This is true for
suppliers as well, if you intend to have them run scheduled processes for structure and component reports
directly in OTBI or through the Reports and Analytics side tab.

- Create Quality Issue: a quality issue is a defect, deficiency, or a significant variation in an item's expected
appearance or performance.

- Create Quality Action: a quality action is a necessary activity required to mitigate a quality issue and prevent
its further occurrences.

Note:
- The availability of an action depends on your privileges and the administrative setup.

- Some of the tasks can also be accomplished from other user interface components.

This action is found only on items (not documents):

- Refresh Cost: retrieve the latest costs for the item or structure, and to perform the cost rollup.

Related Topics
» Use Tasks Panel to Manage Business Objects

« Manage Attachments in Items and Change Orders
» Overview of Change Orders and Change Requests
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Review [tem and Document Changes

The Changes page contains two subcategories, Pending and Released. When you click the Changes side tab of an item,
the ltem Changes and Structure Changes tabs appear. They display either the Pending Changes or Released Changes in
a table format.

The Item Changes tab displays the pending change orders and change requests of the item. The Structure Changes tab
displays the pending change orders across all the items in all the revisions in the structure.

Pending Changes

Displays change orders and change requests that are in the following status: Draft, Open, Interim Approval, Approval,
Hold, and Canceled. To view canceled change orders, you must select Show Canceled Changes.

Released Changes

Displays change orders that are in the Scheduled, and Completed status.

When to Use Change Orders

Manage item revisions by submitting the item for approval by a change order. Attachments and AML must also be
modified through a change order. You can't directly modify a manufacturer or an attachment.

Related Topics
» Create a Change Order and Submit it for Approval

Lifecycle Phases in Product Development

Lifecycle Phases are used as an indicator of the stage for an item or document during the design and development
process. Each phase represents a set of standard tasks or deliverables that are required before promoting an item to the
next phase.

Each item or document must have a lifecycle phase associated with it. An object from a given class can be assigned to
any of the lifecycle phases associated with that class. Before you can create or import items or documents or structures,
the appropriate lifecycle phases must be created and assigned to the class used to create that object or structure (or to
a parent class of the class used to create the object). When a business object is assigned to a lifecycle phase, that phase
is visible as part of the object's attributes. In item or document structures, lifecycle phases name specific processes that
are somewhat different - or in any case named differently - than the phases for the objects on the structure.

Four lifecycle phase types are predefined in the application:
Design;
Preproduction or Prototype;
Production;

- Obsolete.

21
ORACLE



Oracle Fusion Cloud SCM Chapter 4
Using Product Development Items and Documents

To change the lifecycle phase of an item, you must assign it to a change order. You can also reinstate the lifecycle
phase from obsolete to an earlier one.

The administrator can create names for the lifecycle phases that are particular to your company's processes. There can
also be multiple phases based on the same predefined phase; for example, the predefined Production phase can be split
into phases named Production and In Manufacturing, each having company-specific meaning in the steps to build and
ship products.

Related Topics
+ Create a Change Order and Submit it for Approval

Considerations for Lifecycle Phases and Effective Dates

When you change the lifecycle phase or effective date, some restrictions apply.

Restrictions on Promoting Lifecycle Phase

In an item structure containing child items created in Product Development and Product Hub, there's a restriction
when promoting the item lifecycle phase. On promoting the parent item, the application restricts promotion of Product
Development items. However, Product Hub items are automatically promoted.

For example, consider the following item structure that includes items in the Prototype lifecycle phase:

[tem-1 (created in Product Hub)

Item-2 (created in Product Development)

o Item-3 (created in Product Development)

o Item-4 (created in Product Development)

[tem-5 (created in Product Development)
Item-6 (created in Product Hub)

o Item-7 (created in Product Hub)
On changing the lifecycle phase of Item-1from Prototype to Production, here's what happens:

Lifecycle phase of child items created in Product Development remains unchanged.

Lifecycle phase of child items created in Product Hub changes to production.

Restrictions on Demoting Lifecycle Phase

In an individual item, the application restricts demoting the item lifecycle in the following scenarios:

Production to Design
Production to Prototype

Prototype to Design
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Restrictions on Future Effective Date

If you set a future effective date for an item in the design lifecycle phase, the application prompts you to select whether
you want to change the effective date or retain it. Note that the best practice is to make the item effective on approval. A
future effective date might initiate a complex process after the item approval.

Related Topics
» Can I change the lifecycle phase on an obsoleted item?

How Item Grade is Calculated

The Item Grade side tab displays the Item Grade page. The application computes a temporary grade for the item, using
standard rules from the industry.

Documents or manufacturer parts don't support the Item Grade function.

Grade Items in Risky Conditions

Grading is computed for all the Items from the entire item structure. It takes into account certain risk conditions of the
item and its structure to compute the grade. Risky conditions that merit attention and modification may include the
following:

- A child item at leaf node that has no approved manufacturers list (AML).
- A child item that has an unapproved manufacturer part number (MPN).

- A child item which is at a lower lifecycle than its immediate parent item or the structure's top-level item. For
example, a bicycle wheel might be at the Production phase of its lifecycle, while the bicycle itself is still in Pre-
production: because there are other subassemblies that aren't yet ready for Production, this is appropriate. You
wouldn't want the bicycle to have achieved Production phase while its wheel is still in Design. The grade rule
provides an alert on the bicycle's Details tile.

Default Rules

Grade computation can be configured to ignore or take into account any of the rules. You can select one to five of these
issues to be involved in item grading:

Lifecycle Mismatch
Unapproved MPN
Inactive Items

Unreleased Items
No AML

Standards for Grading

These are the default grading standards. The application doesn't count all the instances of violations; it counts an issue
or criteria as "1issue" no matter how many times the issue is violated:

- Anitem with O issues that has an Approved status is graded A.
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- Anitem with 1issue is graded B.

- Anitem with 2 issues is graded C.

- Anitem with 3 issues is graded D.

It can also be configured to use numeric grading, so that the number 5 corresponds with the letter grade "A", 4 with "B",

and so on.

Click an element on the Item Grade tab to discover what issues or conditions affect its grade.

Configure Action Links to Items from Reports

You can create action links (or deep links) to navigate from Oracle Transactional Business Intelligence (OTBI) reports to

specific items.

WN =

o

o

o

Navigate to the Product Development work area.
To create an analysis, click the Reports and Analytics side tab and click Browse Catalog.
To create a report about items and add fields:

In the Catalog page, from the New menu, click Analysis.
Select Product Management: Item Revision Real Time from the Select Subject Area menu.

From the Subject Areas panel, click Item > Main. Use the scroll bar to select Item Name, Item ID, and
Organization ID. Other columns of data are optional.

4. The Item ID and Organization ID don't' work with a decimal value. To set a non-decimal value for the item ID:

o

o

o

o

o

Click Inventory Item ID. From the menu, click Column Properties.
In the Column Properties dialog, click the Data Format tab.
Select the Override Default Data Format check box.

Set the value in Decimal Places to a non-decimal value. Click OK.
Similarly set the Organization ID to a non-decimal value.

5. To configure the name column as a URL that opens the selected object in another tab:

[e]

o

o

In Selected Columns, select the Item Name.

From the menu, click Column Properties. In the Column Properties dialog click the Interaction tab.
From the Primary Interaction menu, select Action Links and create a link format.

Click the + icon to add an action link.

From the New Action Link dialog, select Navigate to a Web Page.

In the Create New Action dialog, add the URL. This creates a web page and passes dynamic values to
load the selected object. The template of the dynamic URL is:

https://<hostname>/productLifecycleManagement/faces/deeplink?
objType=ITEMS&action=EDIT&objKey=itemld=<INVENTORY_ITEM_ID>&orgld=<ORGANIZATION_ID>

Note that:
- Object Type is ltem
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1

12.
13.

O 0™V

- Action is Edit
- Object Key is Item ID
To define parameters:

o Click Define Parameters. The value for the object key is dynamic and the object ID is retrieved from the
report data.

o Click the menu available in the Values column and the third row. Select Column Value and then select
Item ID.

o Click the menu available in the Values column and the fourth row. Select Column Value and then
Organization ID.
o To ensure that the URLs work automatically, select the Fixed and Hidden check boxes in all the rows.

In the Create New Action dialog, add the reference to ltem ID in the URL field.

Click Options to open the Action Options window.

Select the Open in New Window check box and click OK. You return to the Create New Action window.
Click OK. You return to the New Action link window.

. Click OK. In the Column Properties window, select the 'Do not display pop-up if only one addition link is

available at runtime' check box. This helps when there are multiple links with different actions. Click OK.
Click Save Analysis.
Click the Results tab. Click a link in the search results and notice that the object opens in a new window.

Related Topics
» Configure Deep Links in Oracle Fusion Cloud Product Lifecycle Management

Generate Item Structure Report

You can generate and view the item structure report from both the Product Development and Product Information
Management work areas.

1.

Navigate to the Edit Item page of an item.

2. C(Click Generate Report from the Actions menu.

3.

0 03O U A

In the Item Structure Report dialog, select the fields which must appear in the report.
o Levels - Single or all levels of the structure
o Columns - Main, Main and AML, All
o Templates - Default Item Structure Report. You can also include templates you've configured.

If you're unable to view the Default Item Structure report template, ensure that you have the following
role: EGO_GENERATE_ITEM_CHANGE_ORDER_REPORT_PRIV_OBI
o Format - Format of the file here by default is Microsoft Excel.

Click Submit.

Click OK to confirm the message which shows the Scheduled Process Request ID.

Navigate to View Scheduled Processes in the Tasks panel.

Enter the Process Name or Process ID and check the status of the report.

Click the output that appears in the View Output column.

Click the file name or URL in the Attachments dialog and you can view the columns and levels that you
selected.

25

ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20067568

Oracle Fusion Cloud SCM

Using Product Development

Note:

Chapter 4
[tems and Documents

- The columns in the item structure report only display the attributes that you have configured in the template.

- You can generate the report only in Product Development or the Product Information Management work area
and not within Oracle Analytics Publisher; configuration of the template is done in Oracle Analytics Publisher.

Related Topics

« Configure the Template for the Item Structure Report with Additional Attributes

» Configure the Template for the Item Structure Report with the Main and AML Attribute

Considerations for Managing Flexfields in Items and

Change Orders

Item extensible flexfields and item revision extensible flexfields are handled differently in Product Information
Management and Product Development work areas.

Here's what you should keep in mind if you're managing flexfields in both work areas.

Flexfield Type

Item Extensible Flexfield

Item Revision Extensible Flexfield

Best Practices

Product Information Management

Available in items and change orders.

On selecting a revision, only the current
effective values appear.

Appears on the item page where it's configured.

Appears in the change line in the classic
Product Information Management work area,
but not in the Simplified Change Management
Interface.

Here are some best practices for managing flexfields:

Product Development

Available in items and change orders.

On selecting a revision, revision-specific values
appear.

Not supported.

Doesn't appear in the item view or change order
affected objects view.

- In Product Development, you can use item extensible flexfields to track different attribute values by revision
when specific data isn't explicitly tracked through change control.

« In Product Information Management, you can choose not to include item attributes in change control, but still
use item revision extended flexfields to track the difference in values between revisions.

ORACLE
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FAQs About Items and Documents

Why can't | search for items across work areas?

Sometimes you may be unable to search for items by the same criteria using the Manage Items task or unable to
navigate to Item Details page from search results in either Product Development or Product Information Management
work areas.

In this case, perform the Deploy Item Extensible Flexfields task in the Setup and Maintenance work area, using the
Refresh and Deploy Offline option.

Note: You should consult with Oracle Support before running this deployment option in other situations.

Related Topics
« Deploy Item Flexfields

How do | set the parameters used to calculate Item Grade?

Open the Tasks panel, click Manage Configurations. Select the Items tab, and make selections in the Grade and BOM
Grade sections.

What's the difference between the terms released and unreleased
in the My Favorite Items information tile?

It depends on the item lifecycle phase configured by your administrator.

For example, your administrator can configure the prototype lifecycle phase as unreleased, and the production lifecycle
phase as released. Depending on this configuration, the My Favorite Items information tile displays the number of
released and unreleased items.

Related Topics
- Configure Item, Document, and Change Management in Product Development

What's the difference between an item and a manufacturer part?

An item is produced or assembled by your company.

A manufacturer part is entirely produced by an outside manufacturer. It's identified by a manufacturer part number.
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How do | configure the display of operational attributes in the
Product Development work area?

Open the Tasks panel tab, click Manage Configurations. Select the Items tab, and make selections in the Item Attributes
Display Settings section.

How do you change the UOM value after an item is created?

You can update the primary unit of measure of a new item request-enabled item, in the draft status.

If the item is a part of a structure, after you update the UOM, you must check and manually update items in any
impacted structures.

Note: The primary unit of measure won’t be editable for approved items on new item request classes and non-new
item request classes.

How can | quickly edit the details of an item attachment?

On the item's Attachment side tab, click the Direct Edit icon.

How can | promote or demote an item's lifecycle phase?

To promote or demote the item lifecycle phase in Product Development, use a change order on an engineering item.
In Product Information Management, use the item page or a change order for a commercial item. On the item click
Actions > Change Lifecycle Phase.

Note: You can also change the lifecycle phase of an obsoleted item from update 23A onward.

Can | change the lifecycle phase on an obsoleted item?

You can change the lifecycle phase on an obsoleted item from update 23A onward. Here's how:

In Product Development, assign the item to a change order. On the Affected Objects tab, use the New Lifecycle Phase
column.

In Product Information Management, use the item page or a change order for a commercial item. On the item click
Actions > Change Lifecycle Phase.
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Will attachments | add in Product Development show up in
Product Information Management?

The attachment you add for an item Product Development is visible in Product Information Management only if the
Product Development item is in a lifecycle phase higher than design.

Note that the attachment appears as an item revision attachment in Product Information Management.
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5 Quality Management in Items

Overview of Quality Issues and Actions

The Product Information Management and Product Development work areas integrate with the Quality Management
module to help you gain insight to quality issues and actions related to items.

A quality issue is a defect, deficiency, or a significant variation in a product's expected appearance or performance.
Feature for Product Development users.

Feature for Quality Management users.

A quality action is a necessary activity required to mitigate a quality issue and prevent its further occurrences.

Note: On opening an item in the Product Development work area, the Quality tab displays a blue icon, if the item has
quality-related data. And on hovering over the Quality tab, the tooltip displays Quality: Has Content.

The Quality tab displays both these tabs:
- Quality Issues and Quality Actions

Problem Reports and Corrective Actions.

Overview of Problem Reports and Corrective Actions

The Product Information Management and Product Development work areas integrate with the Quality Management
module to help you gain insight to problem reports and corrective actions related to items.

- A problem report is a generic quality incident or problem reported from a customer's perspective.
- A corrective action is an action that you take to address or prevent the problem from occurring again.

You can create problem reports and corrective actions for an item from Product Information Management, Product
Development and Quality Management work areas, and from Supplier Portal.

- On opening an item in the Product Development work area, the Quality tab displays a blue icon, if the item has
quality-related data. And on hovering over the Quality tab, the tool tip displays Quality: Has Content.

- The Quiality tab displays both these tabs:
o Quality Issues and Quality Actions

o Problem Reports and Corrective Actions

To use advanced workflow capabilities such as additional controls and group approvals, create and manage problem
reports and corrective actions just as you would change types in Product Development.
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This is particularly recommended for engineering design use cases where you capture issues related to items. You then
collaborate with suppliers through workflow steps for proper resolution.

These types of problem reports and corrective actions are structured more like change requests. They provide tabs
for General Information, Affected Objects, Tasks, Attachments, Workflow, Impact Analysis, Relationships, Security, and
History.

By configuring the workflow steps, you can:
- Specify automatic status promotion or demotion
- Define entry and exit criteria
- Control who can perform what action
- Perform impact analysis

- Create and assign tasks to track dependencies.

Create Problem Reports and Corrective Actions

You can create problem reports and corrective actions from the:

- Create (+) menu on the Overview page in the Quality management work area
- Actions menu of an item in the Product Development work area

- Actions menu of an item in the Product Information Management work area

You can see that they appear on the Quality tab of items in the Product Development, Product Information
Management, and Quality Management work areas. Remember that the Create Problem Report and Create Corrective
Action options appear on the Actions menu only after you create and save an item.

For suppliers the page reloads with the newly created object.

Note: The newly created problem reports and corrective actions automatically display organization data from the
item.

The workflow of a problem report or corrective action progresses as specified by the statuses defined by the
administrator. For more details, see Set Up Problem Reports and Corrective Actions.

Create 8D Corrective Action.
You can choose to create a corrective action from the following two options in the Type drop-down list:

- Corrective Action — action to mitigate a quality issue and prevent its further occurrence.

- 8D Corrective Actions — action that uses the 8D methodology. An investigative dive to find the cause of a
problem, a solution to fix it and a method to prevent recurrence.

The 8D methodology involves a systematic investigation into the root cause of a problem to prevent recurrence. It uses
a structured, preconfigured template based on 8 disciplines to define the problem, identify the root cause, and run the
corrective and preventative action (CAPA) to prevent recurrence.
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Here's a brief description of the eight disciplines:

1. Plan and form team: Create a plan to minimize or mitigate the problem and establish a team of skillful and
knowledgeable people

Define Problem: define and describe the problem

Interim Containment: define and implement containment actions

Determine Root Cause: identify the root cause

Verify Correction: verify and choose the most effective corrective action

Implement Corrective Actions: implement the corrective actions

Prevent Recurrence: implement actions to prevent a recurrence

Recognize Team Effort: acknowledge and congratulate the collective effort of the team.

NS AWN

Note: Although the change type 8D Corrective Actions is predefined, the attribute visibility setting is read-only. The
change type inherits the configuration from its parent change type, Corrective Action.

Create a Corrective Action from a Problem Report

You can also create a corrective action from the Actions menu of a problem report. The corrective action opensin a
dynamic tab for editing. For suppliers the page reloads with the newly created object.

While creating a corrective action from a problem report, you can select to copy over the descriptive flexfields,
attachments, relationships, and tasks for the problem report. You can also copy over the affected objects including
descriptive flexfields to the new corrective action. The corrective action is automatically linked to the problem report in
the Relationships tab.

Related Topics
» Overview of Change Type Setup

» Configure Change Orders
» Understand Change Types

Access Quality Objects from an Item Structure

This topic describes how you can navigate from an item to related quality objects.

Note that:

- Blue dot icons appear in the Quality column of components on an item’s structure table, to indicate the
presence of quality-related data. Data includes quality issues, actions, problem reports, and corrective actions.

- You can click the blue dot icon to navigate to the corresponding object in the side tab view without losing
context.

You can access and view quality issues and quality actions for all revisions of an item from the Quality tab. You can
access the quality objects from:

« Quality tab in Product Development and Product Information Management work areas.
Navigate to Item > Quality tab.

- Item structure component’s side panel in Product Development work area.
Navigate to Item > Structure. Select a component and click the Quality tab in the side panel.
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Redline item structure component’s side panel in Product Development and Product Information Management
work areas.

Navigate to a Change Order > Affected Object tab. Click the affected object that you want to view. Click the
Structure tab and select a component. Click the Quality tab in the side panel.

You can also perform the following actions from the Quality tab:
« Query by Example
Export to Excel
Detach the Table

Note: When doing QBE on Severity, enter only the text value, and not the numeric prefix. For example, if severity is "1
High', enter only 'High' in the QBE field.

Attributes that appear on the quality issues and quality actions table are similar to the ones that appear on the Manage
Quality page.

I Note: Users with the item privilege EGP_VIEW_ITEM_PRIV can view the Quality tab on the ltem Details page.

Secure Access to Quality Issues and Actions

This topic describes how security is supported in Oracle Quality Management. Use the Security side tab on issues and
actions to add users and roles who can view and search for issues or actions.

Security is applied at two levels:
Functional Security
Data Security

Functional Security

Functional security defines the functions you can perform and the pages and objects you can access. For example, it
defines who can

- enter the quality management work area
- create a quality action
- create a quality issue
The two types of privileges in Oracle Quality Management are:
Manage - lets you create and edit issues and actions
Review - provides a read-only view of the issues and actions.
Functional security in Oracle Quality Management is based on the following privileges:
Manage Quality Action
Review Quality Action

Manage Quality Issue
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- Review Quality Issue

You can assign these privileges only to the user roles, and not directly to the user.

For example, assign John Smith the Quality Analyst user role (which contains the Manage Quality Action, Review
Quality Action, Manage Quiality Issue, Review Quality Issue privileges) to create and edit quality issues and actions. The
two privileges are assigned to specific task flows and menu actions.

While setting up functional security, consider:
- the privileges assigned and the user roles to which they're assigned
- the users, the functions they can perform, and the functionality and work areas they can access

Oracle delivers some users, user roles, and privileges out of the box. The users and user roles can be adapted and
assigned respective privileges.

Data Security

Data security defines access to specific data (records) and is applied in addition to functional security. For example,
even though you can create and manage quality issues (functional security) as a user you may not see the quality issue
"ISSUE46", because the data record isn't visible for your user role (data security).

To enable Data security, you can:
- define data security grants for accessing the issue and action tables for specific user actions

- define data security grants for editing in the issue and action Security tab

- define which users and roles can access a specific issue or action by adding them to the Security tab of the
issue or action

- define which user can see which quality issues based on inventory organization assignment
- grant permissions to perform changes depending on the status of the object.

Data Security Grants on Tables

Data Security grants on the issue and action tables define each user role. All the users who need to see, update or
delete issues and actions, need to be assigned to a user role that grants them access to these data tables with the
corresponding user action.

You can grant overall access to the issue and action table, or access to specific user actions like Read or Update.

Note: Data security grants can't be defined for the creation of issues and actions, as the data doesn't yet exist. Hence,
creation can only be allowed or prevented through functional security.

Data Security Grants on Application Objects

Data security grants are essential to add and remove users and roles on the Security tab of issues and actions. Hence,
you require an additional data grant for application objects on the table FND_OBJECTS for issues and actions.

Data Security Grants Based on Users and Roles on Security Side Tab

The Security side tab for issues and actions makes previously public issues and actions private by assigning them to
specific users and roles.
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After you add the first user and user role to the Security tab, only respective users and user roles (user assigned to these
user roles) have access to these issues and actions. In addition, the Creator and Assignee are automatically granted the
privilege to see the issues and actions.

Permissions to Perform Changes Based on the Object Status

Depending on the type of data, you can restrict the user from editing the issue or action even if the appropriate
privileges and grants are available. For example, if the quality issue or action is:

- logged as Production Exception
- logged as Inspection Non-Conformance
- in a state which prevents editing

You can't edit a record or its relationships; this is to prevent any inconsistencies between production exceptions that you
log in manufacturing and the respective quality issues.

You can't delete inspection non-conformances, but you can perform most editing operations.

You can't edit quality issues and actions if they're in certain states, such as waiting for approval, or after approval and
closure. This ensures that other quality users can rely on the fact that's issues and actions that they approve or have
approved, won't change.

Visibility of Quality Actions and Issues Based on Inventory Organization Assignment

You can assign a specific organization to a quality action or issue to identify where the issue or action has occurred.
Note that users who need to create or access quality issues or actions for an inventory organization must also be
assigned to that organization. You can do this using the Manage Data Access for Users task in the Setup and
Maintenance work area.

If you're using configured job roles to access quality objects, ensure that these job roles are assigned to the right data
security policies in the Security Console, specifically Grant on Inventory Organization.

The following data security function must be entered for user-defined roles in the Security Console for the Quality
Actions Data privileges:

- Policy Name: Grant on Inventory Organization
- Database Resource: Inventory Organization
- Dataset: Select by Instance Set

- Condition Name: Access the inventory organization parameter for table INV_ORG_PARAMETERS for the
inventory organizations in which they can operate.

- Actions: Manage Quality Organization

Access to Affected and Related Objects

You can add items, manufacturing work order operations, manufacturing resources as affected objects to quality issues
and actions. Relate Oracle Innovation Management and Product Development objects like ideas, requirements and
change orders to the quality issue and action.

Functional and data securities govern quality issues and actions. So, even though you can view a related idea or an
affected item, you can't open it unless you have the appropriate privileges.

For example, to open and see the details of an affected item, you not only are required to have functional privileges to
view and manage the item but also have data security grants to the inventory organization.

User and Role Data Security
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The security side tab on issues and actions enables you to add users and roles who can view and find this issue or
action.

The creator and assignees can automatically access the issue or action. Users not listed on the security tab can't find or
view the issue or action.

Related Topics
« Restrict Available Objects Through Configured Roles
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6 Manufacturers and Manufacturer Parts

Overview of Manufacturers

An Approved Manufacturers List (AML) represents a list of manufacturers, suppliers, or vendors approved by a
company for the purpose of procuring manufactured items. You can add manufacturers to the AML tab on an item.

The AML tab on an item captures information about the manufacturers and manufacturer parts associated with the
item.

In the Product Development work area, you can do the following:
- Create manufacturer parts.
- Create the manufacturers and associate them with manufacturer parts.
- Secure access to manufacturer parts.

- Assign the manufacturer parts to the items.

For more information on creating a manufacturer and manufacturer part, see the related topics.

Related Topics
« Create a Manufacturer and Manufacturer Part

» Types of Item Relationship
« Watch Video: Create a Manufacturer and Manufacturer Part

Create a Manufacturer and Manufacturer Part

In the Product Development work area, you can create a manufacturer and a manufacturer part, and then assign the
part to an item.

1. Create a manufacturer using the following steps:

o From the Tasks panel drawer, click Create Manufacturer.

o Inthe Create Manufacturer dialog box, enter the manufacturer name and provide a brief description.
Click Save and Close.

o Enter any additional information, if required. Click Save and Close.
2. Create a manufacturer part using the following steps:

o From the Tasks panel drawer, click Create Manufacturer Part.
o Inthe Create Manufacturer Part dialog box, select the corresponding manufacturer or search for it.
o Enter a manufacturer part number and provide a brief description.

o Select whether you want to activate the manufacturer part, retain it as inactive, or pending. Click Save
and Close.
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o Enter any additional information. Click Save and Close.

3. Assign the manufacturer part to an item, using the following steps:

o Open the item in which you want to assign the manufacturer part. Click the Structure AML tab.

o Select the row of the item to which you want to assign the manufacturer part.

o Inthe side tab, click AML, and click Actions > Select and Add.

o Inthe Add AML dialog box, select the manufacturer and the part number.

o Select whether the part is preferred or alternate. You can assign multiple manufacturer parts to an item.
o Click OK and click Save.

The new manufacturer part is assigned to the selected item.
You can also create manufacturers and manufacturer parts from:

- The AML tab of the item
- The AML tab in the change order

Manufacturer parts can be associated with an item in a structure. The same manufacturer part can be added to multiple
items in a structure. To locate where it's assigned across all items and structures, use the Where Used side tab on the
manufacturer part.

Related Topics
« Watch Video: Create a Manufacturer and Manufacturer Part

Search for Manufacturers

Find manufacturers and manufacturer parts with simple or advanced searches.

Use the Add Fields button on the Manage Manufacturers page to include attributes such as D-U-N-S number, Country,
State, City, and so on, in the search criteria. These attributes appear as columns in the search results table.

Use the Create Saved Search dialog box to include the attributes such as D-U-N-S number of the manufacturers in the
Saved Searches list of the Manage Manufacturers page. Save the search with this additional criteria so that it's available
in the Saved Searches list for reuse.

Note:
- This feature is available only if you've opted in for the feature Upgrade Manufacturer Management.

- If you opt in to this feature, you've to recreate your saved searches in the Manage Manufacturers page.
This feature is available only if you've opted in for the feature Upgrade Manufacturer Management.

Where Used

Use the Where Used side tab on the Manufacturer page to locate where the manufacturer part is used across all
items and structures. Additionally, use the Export to Excel option in the Where Used side tab to share and analyze
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manufacturer data such as manufacturer part number, description, status, created by, creation date, last updated by,
and updated date.

Considerations for Managing AML

If you're using both Product Development and Product Information Management, here are some considerations for
managing AML:

- After you create an item and define its AML in Product Development, it will be visible on the item in Product
Information Management only when the item is in a higher lifecycle status than Design, such as Prototype or
Production. To make changes to the item AML after the item is in production, you must create a change order.

For commercialization or item master use cases, always use the Trading Partner Item Relationships feature
directly in Product Information Management. This relationship enables you to track the manufacturer part
number for an internal item in the same way as the AML.

- You can't control Trading Partner ltem Relationships using change orders, or use predefined fields to track
preference and approval status of manufacturer parts.

- You can delete an AML through import using the Delete transaction type in the change order context.

- You can also add an item to a change order using the import batch option and specify an end date for the AML.

Note: The deletion of AML is recorded in the redline summary.

Secure Access to Manufacturers

Use the manufacturer-specific privileges to securely access the manufacturer data. These privileges provide granular
access control to manage manufacturer data.

Here are the privileges required to secure access to manufacturers:

- Create Manufacturer: You can only create manufacturers with this privilege.
o Privilege: Create Manufacturer (EGP_CREATE_MANUFACTURER_PRIV)

Users who are assigned the Create Manufacturer privilege should also be given the Manage
Manufacturer privilege (EGP_MANAGE_MANUFACTURER_PRIV)

- View Manufacturers: You can view all the manufacturers with this privilege.
o Privilege: View Manufacturer (EGP_VIEW_MANUFACTURER_PRIV)

Manage Manufacturers: You can view and edit the manufacturers.
o Privilege: Manage Manufacturer (EGP_MANAGE_MANUFACTURER_PRIV)

Note: This is available only if you opt in to the feature: Upgrade Manufacturer Management.
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Secure Access to Manufacturer Parts

Use the Security tab on the manufacturers and the manufacturer parts to secure access to manufacturer parts. You can
add the users and roles (groups) who should have access to manufacturer parts.

Note:
- This is available only if you've opted in for the feature: Upgrade Manufacturer Management.

If you opt in to Upgrade Manufacturer Management and use granular privileges, you can access the Security
tab only if your role has these policies assigned to it:

o EGP_TRADING_PARTNER_ITEMS
o EGP_PRIVATE_TRADING_PARTNERS

Secure Access to All Manufacturer Parts Created for a Manufacturer

Here's how you secure access to all the manufacturer parts created for the manufacturer.

1. Click the Security tab on the manufacturer.

2. Deselect the Public check box.

3. Click Create to configure a person or a group to access manufacturer parts.

4. Select whether you want to grant access to a person or a group, and select the name of the person or the group.
5. Select the privileges you want to provide:

o View: allow users to view the manufacturer part.
o Maintain: allow users to edit the manufacturer part.
o Administer: allow creating new manufacturer parts for the manufacturer.

To allow more persons or groups to access manufacturer parts, repeat the previous steps.
6. Save your changes.

The security is inherited by all manufacturer parts created from the manufacturer.

I Note: To revoke access to a person or group, select the person or group and click the Delete button.

Secure Access to Individual Manufacturer Parts

Prerequisite: You must enable security on the trading partner item using Manage Trading Partner Items > Edit
Trading Partner, in the Product Information Management work area. This will allow you to view the Security tab on the
manufacturer part (in the Product Development work area).

Here's how you secure access to an individual manufacturer part.

1. Click the Security tab on the manufacturer part.
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2. Click Create.

3. Select whether you want to grant access to a person or a group, and select the name of the person or the group.
4. Select the privilege you want to provide:
o View: allow users to view the manufacturer part.

o Maintain: allow users to edit the manufacturer part.

Note:
o A check box appears in the Inherited column if the grant is inherited from the manufacturer.

o The Security tab isn't displayed on the supplier portal.

Additional Considerations

- The Security tab on the manufacturer page shows updates made to the Public setting and data grants
on the trading partner in the Product Information Management work area. Likewise, such updates to the
manufacturer made in Product Development are replicated on the trading partner page in the Product
Information Management work area.

- Manufacturer parts inherit the grants added to the parent manufacturer, but the security tab isn't displayed on
the manufacturer part. Edit the trading partner item to see these inherited grants and add additional singular
grants in the Product Information Management work area. These individual grants apply to the manufacturer
part and item AML.

Related Topics
 Data Security for Manufacturers and Manufacturer Parts

» Create and Edit Trading Partner Iltems

Create Manufacturer Part Using Save As

You can use the Save As feature to create a new manufacturer part from the Actions menu on the Manufacturer Part
page.
Here's what you can copy over from an existing manufacturer part:

- Attachments

- Additional Information such as descriptive flexfields

- Security Settings

- You must have the Manage Manufacturer Part privilege to use the Save As feature; if you don't, the Save As
option is grayed out.

- If the source manufacturer part is private, then you must have a Maintain grant privilege to use the Save As
feature.

Created From
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You can track which manufacturer part was used to create a new part using the Created From field on the General
Information page. This field displays a link to the source manufacturer part from which the current manufacturer part
was created. You can click this link to navigate to the original part and view the details.

- The Created From field displays the source manufacturer part name.

In the Save As dialog box, if you change the manufacturer from the source manufacturer, the Save As dialog
box displays the grayed out Security check box. The manufacturer part instance grants aren’t copied to the new
manufacturer part.

Note: The Supplier Portal doesn’t provide the Save As option or display the Created From field on manufacturer
parts.

Create OTBI Reports for Manufacturers and Items

You can create reports in Oracle Transactional Business Intelligence (OTBI) for manufacturers, and manufacturer parts
along with items.

You can also analyze manufacturers by various criteria such as:
- configured attributes
- location attributes such as Country, State, and City and

- manufacturers without associated manufacturer part numbers.

Related Topics
» Use Reports and Analytics

FAQs About Approved Manufacturers List

How can | search for manufacturer parts based on specific
attributes?

From the Tasks side tab, select Manage Manufacturer Parts.
On the Manage Manufacturer Parts page, you configure the criteria to search for manufacturer parts.

Click Add Fields to add more attributes to the search criteria. The attributes appear depending on the descriptive
flexfields configured by the administrator.
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Why can't | add a manufacturer part to an item?

The item might be assigned to a change order with a pending revision.

Will the approved manufacturers list (AML) | add in Product
Development show up in Product Information Management?

The AML you add for an item in Product Development is visible in Product Information Management only if the Product
Development item is in a lifecycle phase higher than design.

Related Topics
« QOverview of Manufacturers

What's the difference between manufacturers and trading
partners?
Manufacturers and trading partners mean the same, but the terminology differs based on the work area.

The Product Development work area uses manufacturers and manufacturer parts.

The Product Information Management work area uses trading partners and trading partner items.
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7 Structures

Overview of Structures

In Product Development, a Bill of Materials is called a structure.

When you add an item to a parent item, you create a simple structure. As items are added, the structure is always
named and referred to by its top-level item.

A structure holds all the items and documents that make up an assembly or subassembly. ltems and documents may be
in the same structure; there's no restriction on the maximum or minimum number of either type of business object.

Any item on a structure may be associated with one or more manufacturer parts. On the Structure table, an icon next
to an item indicates the presence of manufacturer parts. So, a structure populated with items will likely comprise
associated manufacturer parts.

A document structure holds all the documents that make up a meaningful document, such as a specification for a
product. When you add a document to a parent document, a simple structure is created. A structure of documents will
be named and referred to by its top-level document. A document structure may be only one document.

Create Structures

You can create a structure by either selecting and adding existing items, or creating new items. Use the Actions and
View menu on an item to create and modify the structure.

Here's how you create a structure:

1. Open the item and navigate to the Structure tab.
2. To add a new item in the structure, click Actions > Create.
3. To add existing items to the structure, click Actions > Select and Add.

Note: You can't add a parent component to a child component. This applies to both preliminary structures and
affected item structures on engineering and commercialization change orders. You can add duplicate components
to a structure if you opt in to the feature Add Find Number and Suggested Operation Sequence for Structure
Components. This feature allows you to differentiate between multiple instances of a component within a structure
using find numbers.

Create an ltem and Build an Item Structure

This topic covers how to create an item and build an item structure. A structure contains information on the parent item,
components, and descriptive elements.

1. In the Product Development work area, create an item using the following steps:
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o From the Tasks panel tab, click Create Item.
o Inthe Create Item dialog, select the class in which you want to create items.
Note:

- You can only select an item class for which you have been assigned privileges.
- When you create an item in a child item class, the attribute values are applied only

from the default template for the child class and not from the item class hierarchy.
o Enter a name for the item and provide a brief description.

The name and description can be generated automatically by configuring the item class.
o Select the primary unit of measure for the item.

o Enter the value for item attributes.

Attributes and their values appear only if they're configured for the item class. You can use the
predefined values or modify them.
o Click Save and Close.

2. To copy existing items that you want to use for building the item structure, do the following:
o From the Tasks panel tab, click Manage Items.
o Enter a criteria to search for existing items and click Search.

o Inthe search results page, select the items you want to add to the item you created. Note that you can
use the control key to select multiple items.
o Click Copy and click Done.

The items are copied to the clipboard.
3. To build the item structure using the items you copied, do the following:

o Inthe item that you created, click the Structure tab.
o Click the Paste icon. The items are pasted to the structure.
o Click Save.
4. To create a new item and add it to the structure, do the following:
o Inthe item that you created, click the Structure tab.
o Click the Create icon.
o Inthe Item Create dialog box, enter the details of the new item.
o Click Save and Close.
5. To add an existing item to the structure, do the following:
o Intheitem that you created, click the Structure tab.
o From the Actions menu, click Select and Add.
o Enter the criteria to search for the existing item and click Add.
o Inthe Select and Add dialog box, select the item.
o Click Apply and Close.
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Related Topics
« Watch Video: Create an Item and Build an Item Structure.

View and Edit Structure Details

To view the structure component details in a side panel, select a component row on the structure tab of the item.

The header of the side panel shows the name of the selected component. You can move from one component row to
another, and use the side panel to navigate easily between the component details.

You can enter the following component details from the side panel: reference designator, additional information,
attachments, AML, additional attributes, and substitute components.

Note:
- You can edit a component from the item structure page, if it's not assigned to any change order.

+ You can edit reference designators using the side panel, if your administrator has set the Reference
Designator Range Indicator to None. Otherwise you can edit them directly in the structure table.

- If you have added a component to a common structure associated with one or more organizations, and one
of those organizations became inactive, the assignment to the inactive organization is skipped, and this
information is recorded in the log file.

Icons on Component Rows

The pencil icon in a column indicates that there's additional information that you can view. You can click the icon to
navigate to the corresponding tab in the side panel view.

The following icons appear only if you've opted in for the feature User Interface Improvements for ltems and Changes.

- A blue dot icon in any of the following columns of a component row - attachments, AML, substitute
components, pending changes, and quality - indicates the presence of content. Click the dot icon to navigate to
the corresponding tab in the side panel view.

- For quality-related data, the blue dot appears if there’s at least one quality issue, quality action, problem report,
or corrective action in any workflow status against any item revision. If no issues or actions appear against the
item you've chosen, select other revisions and see which ones have issues or actions logged against them. With
problem reports and actions, you can see them across all revisions of the item.

- Inthe redline view of the affected item’s structure, the reference designator, and substitute component icons
appear in blue when there are redlines.

Note: The structure component attachments, AML, additional attributes, pending changes, and quality tabs on the
side panel appear in the read-only mode on engineering change orders.
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In the following image, you can see the blue dot icon in the Changes column indicating the presence
of content in it. You can click the blue dot to open the Changes side tab for the selected component.
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Points to Consider
- The affected item's structure tab on a commercialization change order doesn't include side panel tabs for
attachments, or AML. It also doesn’t have the blue dot icons for Pending Changes or Quality related data.

- Pending Changes and Quality side panel tabs aren't displayed in the Supplier Portal.

Find Number

You can differentiate duplicate components in an assembly using the Find Number attribute. Note that this feature
is applicable only if you opt in to the feature Add Find Number and Suggested Operation Sequence for Structure
Components.

The find number identifies a specific instance of an item in a structure. When a duplicate component is added, the
application will automatically increment the find number, but you can modify it before you save your changes. Once the
item is saved, here’s how you can change the find number:

Delete the component and add it again with the new find number.
Or
Use the Replace action to replace a component with the same component and provide a different find number.

Example: Consider that a server containing 4 similar processors is positioned at the same level in the structure. Each
instance of the processor will have a unique find number. This will allow you to have duplicate instances at the same
level in the BOM, and differentiate each instance.

Here are some additional details:

- You'll be prevented from creating duplicate find numbers for Model and Option Classes. The Find Number
column will be displayed and defaulted to 1. Also, you can't add the duplicate component row.

- You can't create overlapping effectivity dates for the combination of component and find number.

You must ensure that the date range of the duplicate component is outside the date range of the initial
component. Note that the date range is calculated based on the start and end dates of the component.
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- Attributes such as Quantity, Basis Type, and Supply Type can have a different value in the duplicate row.
Similarly, structure entities such as substitute components and reference designators can also have a different
value in the duplicate row.

- Find Numbers are automatically incremented when you add duplicate components in the user interface, but not
when you update structures using REST services or import.

« Intheitem structure import, if the find number value isn’t provided, it will be defaulted to 1. If you have a
duplicate instance of the component in your structure, you must provide a unique find number value in import.
In the absence of the unique find number, the import will create a single component with the find number value
defaulted to 1and the other components won't be created. This is applicable for REST APIs and SOAP Services
as well.

- If you perform a Replace action to update the New Find Number value using import, it's recommended not to
import changes to other attributes in the same import batch.

Here are the best practices and recommendations:

- All existing and new customers should use Item Sequence for sequencing the structure. It's recommended not
to use Find Number for sequencing of the structure. Find number should only be used to include duplicate
components in a structure.

- Agile PLM customers migrating to Oracle Fusion Cloud should map Agile PLM Find Number to Item Sequence.
- CAD integration customers should map Agile PLM Find Number to Item Sequence.

- Agile PLM MCAD customers using the find number feature must map Find Number to structure component
descriptive flexfields.

Suggested Operation Sequence

You can use the Suggested Operation Sequence column to record a design engineer's suggestion for the operation
sequence of components in a manufacturing work definition. This doesn't have a default value and isn’t automatically
incremented.

Note:
- This feature is applicable only if you opt in to the feature Add Find Number and Suggested Operation Sequence
for Structure Components.

- Suggested operation sequence isn’t a required value.

Example: In an assembly that includes 3 components, you can suggest an operation sequence for component A as 1,
component B as 2, and component C as 3. The manufacturing team can refer to this to specify a sequence for assembly
of components (in the manufacturing work definition).

Related Topics
» Can I modify the find number when the item is on a change order?
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Key Actions and Features on a Structure Page

Here are some of the key actions and features available on the toolbar or the Actions menu on a structure.

- Fill Up (Ctrl+U), or Fill Down (Ctrl+D), and Fill Selected (Ctrl+S): you can quickly fill in attributes when you've
added new items (this is also available when modifying a change order).
o FillUp (Ctrl+U) and
o Fill Down (Ctrl+D) are available when you've selected a consecutive range of rows. Remember that
you've to select the table cell and modify the value in the cell for Fill Down and Fill Up to work.
o Fill Selected (Ctrl+S) is available when you have used Control-click to select nonconsecutive rows.

Note that the Effectivity Date attribute isn't automatically populated.

- Search: Enter the criteria to search for components within the structure. The application performs a search
based on the component name and description.

- Quantity Related: Select this to validate whether the item structure quantity matches the reference designator
count. A message appears in case of quantity mismatch. This is enabled by default in Product Development
structures. This action is also available on the reference designator dialog box.

- Align Quantity: Select this to automatically update item quantity to match the reference designators count.
This action is also available on the reference designator dialog box.

- Set Quantity Related to No: Select this to disable the Quantity Related setting that creates a dependency
between component quantity and the number of reference designators. If the Quantity Related field is set
to No, the application allows a mismatch between the component quantity and the number of reference
designators entered for the selected component.

- Set Quantity Related Field to Yes: Select this to enable the Quantity Related setting that creates a dependency
between component quantity and the number of reference designators. If the Quantity Related field is set
to Yes, the application checks whether the specified component quantity matches the number of reference
designators entered for the selected component and displays a warning if there’s a mismatch.

- Freeze: This is useful when you want to work with a large amount of component data spread across multiple
columns in the item structure. To freeze a column, select the column and click Freeze. Scroll through the
columns keeping the frozen column in context. For example, you can keep the item name column frozen and
scroll to view all its additional attributes.

For more details, see Freeze Structure Columns on Change Orders.

Replace a Component

You can replace a component in your item structure, copying over key data from the original component to the
replacement component.

You can replace a component from:

- anitem structure page in the Product Information Management work area
- achange order’s Affected Objects Structure tab in the Product Development work area
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How You Replace a Component

1.

Depending on your work area, here’s how you select the component you want to replace.
In Product Development,
o Open the change order that contains the component you want to replace.

o Click the Affected Objects tab and select the component you want to replace.

In Product Information Management,

o Open the item that contains the component you want to replace.
o Click the Structures tab and select the component you want to replace.

Click Actions > Replace. You can also use the Replace icon on the toolbar.
Search for and select the replacement component.

The original component is redlined and the replacement component appears in green (which is different from
the initial color). The original component also appears in the Replaces column for your reference.

End date of the original component becomes the start date of the replacement component.
Save your changes.

In the Product Information Management work area, you can save your changes to the item or save the changes
to a change order and route it for approval.

How Start and End Dates are Derived

The table lists how the start and end dates are derived upon replacement.

In Product Development In Product Information Management

Upon replacement, the end date of the
original component and the start date of
the replacement component will be the
same as the effective date of the affected

object.

Upon replacement, the end date of the original component and the start date of the replacement
component will match the date in the Date field on the toolbar of the item structure page.

If the affected object is effective on

approval, this will be the date when the If a replacement is to be effective only in the future, select a future date in the toolbar and then perform
change order is moved to Scheduled the Replace action. The replacement is visible in the structure when the date selected is after the start
status. date of the replacement component.

If the affected object has a future effective
date, this will be the same as the effective

date.

What's Copied Over to the Replacement Component

When you replace a component, item sequence, structure component attributes, substitutes, and reference designators
are copied over from the original component to the replacement component.

Here are the attributes that are copied over:
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Component Attributes

Item Sequence - Read-only
« Quantity
- Yield
- Comments
- Start Date
End Date
Planning Percent
« Check ATP
Required to Ship
Required for Revenue
Include on Shipping Documents
- Automatically Request Material
Basis
Enforce Integer Requirement
Supply Type
- Component UOM

Substitute Components

[tem
Description
Primary UOM
+ Quantity
Inverse Quantity
Priority
Enforce Integer Requirement

Descriptive flexfields
Reference Designator
Reference Designator

Description

Descriptive flexfields

Considerations for Replacing Components

The table shows considerations for replacing components based on the work area.
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In Product Development

- You can't replace a component that
is already a replacement for another
component in the same change order.

- You can use the Undo Redlines action
to revert the replacement action when
the change order is in Open or Interim

Approval status, provided you have the

permission to perform the action. This

permission is defined in the Additional

Workflow Controls table in the change
type setup.

- If you're replacing an item with a

document, then the reference designators

aren't copied to the replacement.

« Inthe Change Order Details report,
replacement attributes are displayed

regardless of whether you opt in for this
feature or not. These attributes can't be

hidden.

Track Replacements

In Product Information Management

Once a replacement is selected, neither
the original nor the replacement
component can be edited.

The Replaces column is visible by
default and retains the record of replaced
components even when you enter future
dates in the Date field. The original
component is shown in the Replaces
column until it's replaced with another
component.

Chapter 7
Structures

Across Product Development and Product
Information Management

If a component has redlines, for example,
the quantity is updated, the component
can'’t be replaced.

If the replacement component selected
has a different UOM from the original
component, a warning message appears
and the quantity is reset to 1. Reference
designators and substitute components
aren’t copied over. The replacement
component's UOM will show the item’s
primary UOM.

If the replacement component was
defined as a substitute component of the
original component, then it isn't copied
to the substitute component table of the
replacement component.

You can generate the Change Order Details report to track replacements made to structure components using the
change order. Here are some points on the report:

- Replacement attributes can't be hidden.

- The Replaces column appears in the Structure Changes table showing the original component that was

replaced.

- The Change Action column shows the replacement component as Added and original component as

Disabled.

- Copied reference designators and substitute components are shown against the row marked Added.

- Change Action and Replaces attributes are shown in the Pending Component section.

Add Reference Designators on Items

Reference designators commonly serve as a labeling system to refer to components.

If your administrator has configured reference designators for adding them inline with item components, here's how

you add them:

1. Navigate to the Structure tab on the item and select a component in which you want to add reference

designators.

2. Inthe Reference Designator column, click the expansion button '..."

3. Inthe Reference Designator dialog box, enter the range for designator values.

ORACLE
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For example, if your administrator has selected '+' as a range indicator, you can enter 'A1+ A5' and the
application will expand the range to create five reference designators: A1, A2, A3, A4, and A5. The expanded
range appears in the side panel once you save your changes.

Additional options in the Reference Designator dialog box:

o Quantity Related: To validate whether the item structure quantity matches the reference designator
count, select this option. A message appears in case of quantity mismatch. This is enabled by default in
Product Development structures.

o Align Quantity: If the structure item quantity doesn't match the count of reference designators, select
this option and click OK. This would allow automatic update of item quantity, to match the reference
designators count.

Note: You can also access Quantity Related and Align Quantity functions from the toolbar of the Structure
tab, and the Actions menu. To modify the details of reference designator, you can use the Reference
Designator dialog box or the Reference Designator column.

4. Click Save.
To view and modify descriptive flexfields, you can use the side panel.

Note: Modified reference designators appear in italicized red colour after you save your changes.

Related Topics
- Items and Documents in Product Development

- View and Edit Change Details
« Define a Change Order

Delete a Component

When you delete a component, here's how the side panel displays details:
- If you delete a component row, the side panel automatically displays details about the next component.

- If all components are deleted, the parent component detail is displayed.

« When you select multiple components and delete them, the side panel displays details based on the
component you select first. For example, if you first select the component named Component_2, then the side
panel displays information about the next component named Component_3.

Note: You can’t delete a component if the structure is created in the Product Information Management work area.
If you want to delete the component from the structure, you must do it from the work area where the structure was

created.
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Rules About Item Structures

Here are some rules about item structures.

During the Item Lifecycle Phase

- You can’t reinstate the parent item in a structure if the child component is marked obsolete.

- You can assign an item in Draft approval status to an item structure.

- A component's lifecycle phase should be the same or higher than the parent assembly's lifecycle phase; this
applies to items of lifecycle phase Preproduction or Production only.

If an assembly is approved, components in the draft status can't be added. This applies to items of lifecycle
phase Preproduction or Production only.

- A hand-over of a structure to the downstream processes is triggered by changing the lifecycle phase of the
parent item to Preproduction or Production.

When You Create Change Orders

- You can edit an item without going through change management control, only if the item isn't assigned as an
affected object to a change order.

If you're unable to add an item to a structure, here are some of the possible reasons:

o

o

o

There's another, later revision of the parent item.
The parent item is on a change order with a pending revision.

The item was earlier assigned to a change order and the change order is complete. So you're not allowed
to modify the item's attributes, structure, AML, or attachments. To modify the item, assign it to a new
change order.

The item is a duplicate component, or you're adding a parent component to a child component.

The restriction on adding a duplicate component doesn't apply if you opt in to the feature Add Find
Number and Suggested Operation Sequence for Structure Components. This feature allows you to
differentiate between multiple instances of a component within a structure using find numbers.

If the item is a commercial item, you can't add it to an engineering change order.

When You Deprecate Items

- You can deprecate an item if it isn't used in another structure.

- A child item can still be active if its parent is obsoleted.

- A child item can't be obsoleted if the parent item is active.

To Calculate Item Grade

- You can add items or other subassemblies to the top-level item. After you add the items, the grade of the top-
level item must be refreshed. This results in a display of a newly calculated value of the grade.
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The grade of the entire top-level assembly or item takes into account various statuses of the child items within
the structure.

You must examine a structure to see which items don't have an AML or which ones have pending changes.
Based on these conditions, you can decide to improve the grade, and then publish the item for manufacturing
readiness.

Manage Substitute Components

You can add and update substitute components for items, from the contextual side panel on the item structure tab.

Here's how:

1.

2.
3.
4.

Launch the item from the Affected Objects tab on a change order.

Click the Structure tab on the item.

Select the component for which you want to add the substitute.

In the side panel, select the Substitute Components tab to add the substitute.

Here are some details on managing substitutes:

Only the structures of preliminary items (items that have never been released before) can be updated. Similarly,
only substitute components in preliminary stage can be updated. Once released, components and substitutes
can be updated only through an engineering change order.

The lifecycle phase of the substitute should be the same or higher than the component. You can add a
substitute component belonging to a lower lifecycle to an item, only when a released item with a higher lifecycle
phase than design is allowed to be added to a preliminary item by disabling lifecycle validation.

Note: To disable lifecycle validation deselect the Enable Lifecycle Validation check box in the Item Structure
Type Details task. To access the task, in the Setup and Maintenance work area select Product Management
offering > Functional Area: Structures > Item Structure Type Details.

If you have a parent item which is preliminary, you can add components that are released or preliminary. In both
these cases, you can add substitutes. You can also add substitutes to a sub-assembly.

You can't add a parent item as a substitute.

When you add a substitute in the side panel, the quantity is defaulted to the original component value and can
be edited.

Once released to a pre-production lifecycle, only the additional attributes (descriptive flexfields) can be updated
in the Product Information Management work area.

You can identify where an item is used as a substitute by using the where used query on the item structure
page.

Related Topics
« View Item and Document Details
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Import an ltem Structure

Importing structures of items is similar to importing regular items. When you intend to collect items in a structure and
then import that structure, the regular items must first exist in the application.

If some or all items going into the structure don't exist already in the application, these items must be created or
imported before you design and import the structure.

1. Download the ltem Structure Import template file from the following guide: Oracle Fusion Cloud SCM File-
Based Data Import (FBDI) for SCM.

This guide contains information about the template.
2. Enter the item information on the EGP_STRUCTURES_INTERFACE tab:

o

o

o

o

o

Set the Transaction Type to SYNC.

Enter a Batch ID such as 200.

Enter the Structure Name such as Primary.
Enter an Organization Code such as 000.
Enter the Item Name.

In the EGP_SYSTEM_ITEMS_INTERFACE tab, you need not enter the item version start date. The application
calculates this value based on item effectivity date in the EGP_ITEM_REVISIONS_INTERFACE tab. In case of
multiple item revisions (or effectivity dates), the earliest date is considered.

3. Enter the structure information on the EGP_COMPONENTS_INTERFACE tab:

o

o

o

Set the Transaction Type to SYNC.

Enter the same Batch ID as on the EGP_STRUCTURES_INTERFACE tab.

Enter the Structure Name as Primary.

Enter the same Organization Code as on the EGP_STRUCTURES_INTERFACE tab.
Enter a child item in Component Item Name.

Enter the parent item in the Structure Item Name.

Enter a number for the component item sequence which determines the order in which child items are
listed. In the absence of a sequence number or in case of a duplicate sequence number, the application
automatically generates the sequence number.

Enter a number for the quantity of each item.

4. Generate CSV files:

o

o

o

Select the Instructions and CSV Generation tab and click the Generate CSV File button.
Click Save each time the macro prompts to do so.
Locate the zip file that was generated by the macro.

5. Import the zip file:

o

o

From Navigator, open File Import and Export.

Click the Create New + icon.
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o

o

o

Click the Browse button and locate the zip file that was generated by the macro.
In the Account field, select SCM / item / import.
Click Save and Close.

6. Load data to interface tables:

o

o

o

[e]

From Navigator, open Scheduled Processes.

Click the Schedule New Process button.

Search for and select Load Interface File for Import as the process name.

Click OK.

Select Item Import as the Import Process.

Select your zip file as the Data File.

Click Submit.

Note the process number.

Click the Refresh icon on the Scheduled Processes Overview page to watch for the process to complete.

7. While still in Scheduled Processes, click the Schedule New Process button.

Search for and select Item Import and click OK.

Enter the same Batch ID that you put in the spreadsheet.
Select the same organization that you put in the spreadsheet.
Set the other fields as required.

Click Submit.

Note the process number.

Click the Refresh icon on the Scheduled Processes Overview page to watch for the process to complete.

FAQs About Structures

How can | view the manufacturer parts used in an item structure?

On the Edit Item page, click the AML tab.

The following subtabs appear:

ltem AML subtab - lists the approved manufacturers for the item.

« Structure AML subtab - lists the manufacturer part numbers used in the structure of the item.
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How can | view attachments for all the components of an item
structure?

On the Edit Item page, use the Actions menu to download the report containing attachments for all the components of
an item structure.

How can | find out when the component is added and removed
from the structure?

The start date and end date fields on the item structure page indicate the date when the component was added and
removed from the structure.

Why can't | modify the structure?

Because the item structure either has another revision or is on a change order with a pending revision.

How can | reinstate a parent item in a structure that contains
obsolete components?

You must first reinstate the obsolete components and then reinstate the parent item.

Can | use a replaced component in another item?

Yes. For instance, you replaced a component because a buyer rejected it based on company regulations. But you can
still use the component in another item where the regulations don't apply.

Related Topics
- Replace a Component
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How can | remove an obsoleted component from an item
structure?

Change the lifecycle phase to Production and remove the component from the item structure. Then change the lifecycle
phase to Obsolete.

To change the lifecycle in the Product Development work area you must create a change order and release it. But in the
Product Information Management work area you don’t have to create the change order.

How can | compare different revisions of the same item?

On the Structure tab of the item, use the Actions menu and select Compare Structure. In the Compare By list, select
Revision. You can compare different revisions of the same item or different items.

How can | inform other users about my new item structure?

Select Send Object in the Actions menu and add the users you want to inform.

In a structure, how can | view the items available in an item class?

Export the item structure using the Export to Excel icon and filter the spreadsheet to view items by the item class.

You can also view the item class on the Structure and Where Used tabs of the item.

In a structure, how can | manage mismatches in lifecycle phase?

To manage the lifecycle phase for a structure type, use the Enable Lifecycle Phase option available in the Manage Item
Structure Type task.

To access the Manage Item Structure Type task, navigate to the Setup and Maintenance work area. Select the Product
Management Offering, and Structures functional area.

Select the Enable Lifecycle Phase option to manually correct any mismatches in lifecycle phase. Deselect the option to
allow creation of item structures with components at a lower lifecycle phase than the parent item.

The changes you make to the Enable Lifecycle Phase option don't impact existing structures. For such structures you
must manually correct the mismatches in lifecycle phase.
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Why can't | access the item structure and edit its AML and
attachments?

To view and update the item structure, you must have the Maintain Item Structure security grant assigned to your role.

To edit AML and attachments, you must have the Maintain Item Basic security grant.

Related Topics
« Set Up Data Security for Item Classes

Can | modify substitute components?

Yes. You can modify substitute components using an engineering change order.

Related Topics
- Manage Substitute Components

Why am | unable to view the Substitute For column in the structure
details?

Ensure that you've selected Include Substitute Components in the search filter and the Substitute For column in View
> Columns.
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8 Change Management

Overview of Change Orders and Change Requests

Change orders and change requests let you process changes to items, and documents. Change orders allow you to
markup the required changes, and the changes become effective on approval. But change requests don't provide any
markup.

Note: Change objects may be referred to generally as change orders, change requests, or changes. However,
when being specific about change types that your company may use to create individual change objects, you must
differentiate between change order and change request types.

As a product manager you can manage change orders. Your users can:
- Create change orders within predefined change types.
- Author and view product changes.
- Submit changes for review and approval.
- Track change statuses.
Implement changes on a scheduled date.

To ensure successful and validated completion of change orders, changes are submitted through a formal review and
approval workflow.

Change Types

You can create change orders based on the predefined change types setup by your administrator. To create a change
type:

In the Setup and Maintenance work area, go to the following:
- Offering: Product Management

Functional Area: Change Orders
- Task: Manage Change Order Types

Note: For details of all notifications in Product Management, see View Product Management Notifications on the
Oracle Help Center.

To use change orders, you must create at least one change type. The change type can be end-dated if it's not used in
any change orders that have a workflow in progress.

To create a change type based on predefined types:

In the Setup and Maintenance work area, go to the following:

- Offering: Product Management
Functional Area: Change Orders

65
ORACLE



Oracle Fusion Cloud SCM

Using Product Development

- Task: Manage Change Order Types

This table provides information on the predefined change types and supported features.

Change Type

Engineering Change Order

Change Order without
Revision Control

Change Request

Deviation Change Request

Commercialization Change
Order

Problem Report

ORACLE

Description

Used when tracking major
changes during the design
phase of the item.

The revision number is
automatically incremented
when you make changes.

Used when revision control
isn't required or when
changes are minimum.

For example, replacing an
existing manufacturer part
with a similar part supplied
by another manufacturer.

Used when suggesting
changes for a released
item.

For example, a supplier
could request changes in
certain specifications.

Used when deviating from
a process or specification
for a specific time period.

For example, suggesting
the use of a substitute
component as a temporary
means of resolving an
issue.

Used during the
commercialization phase of
the product. Can be created
and edited in Product
Information Management.
Also available in Product
Development as read-only.

Used to implement
Quiality Management

for engineering design
and development
through Oracle Product
Development Cloud. It's
also required to enable
supplier collaboration for

Supports Revision Control

Yes

No

No

No

Yes

No

Supports Audit Report

Yes

Yes

No

No

No

No

Chapter 8
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Supports Redline
Modifications

Yes.

Displays the following
modifications in redline:
item detail, EFF, structure,
AML and attachment.

Yes.

Displays the following
modifications in redline:
AML, EFF, and item detail.

No

No

Yes

No
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Change Type Description Supports Revision Control Supports Audit Report Supports Redline
Modifications

issue identification and
resolution.

A problem report is a

type of quality issue,

such as a defect,
deficiency, or a significant
variation in a product's
expected appearance or
performance.

This change type is
applicable only for users in
the Quality Management
work area.

Corrective Action Used to implement No No No
Quiality Management
for engineering design
and development
through Oracle Product
Development Cloud. It's
also required to enable
supplier collaboration for
issue identification and
resolution

A corrective action is a type
quality action to mitigate a
quality issue and prevent its
further occurrence.

This change type is
applicable only for users in
the Quality Management
work area.

Note: The 8D corrective action is 'inherited from' the predefined corrective action change type and hence you can't
view it in the drop-down list of change types in manage change types.

Related Topics
« Define a Change Order

« View and Edit Change Details
» Create a Change Order and Submit it for Approval
« Use Predefined OTBI Dashboards for Changes and Items
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Define a Change Order

Here's the sequence of steps to define a change order.

1. Create the change order, giving it an appropriate name and purpose or description.
2. Assign items and documents that are affected by the change order.

o Manufacturer parts can't be added to a change order; you must add a manufacturer part's associated or
parent item.

3. Edit the item or document and modify their definitions:

o Update the item or document attributes; or,
o Modify the structure, in these ways:

- by adding new structure components;
- by withdrawing existing structure components; or,
- by modifying structure attributes.
4. Check the impact of the change by analyzing the impacted products.
5. Adapt the change to impact the intended products only.
6. Define the list of approvers for the change - individual users or user group. If the user group is expanded into a
comma separated list, the number of characters in the list should not exceed 2000.
7. Submit the change order for approval.
8. Approvers review and then approve or reject the change.
9. If rejected, rework the change and resubmit for approval.
To add an affected object to the change:

Open the Affected Objects panel.

Open the Actions list and select Add. Or use the + Add icon.

Search for appropriate items or documents.

From the returned search results, use the arrow to assign an affected object.
5. Save your modifications.

To change the revision of an affected object on the change:

PUOUN

1. Inthe row of the affected object, you can make a manual change to the revision.
2. Save your modifications to the business object.
To change the metadata attributes of a business object that's held on a change:

Select the affected object.
Open the Actions list and select Edit. The object's Details page displays.
Modify object attributes.
4. Save your modifications to the business object.
To change the structure of a business object that's held on a change:

WN =

1. Click the affected object.

The object details page appears.
2. Switch to the item or document structure by clicking the Structure icon.
3. Add a new item or document structure component. Or, Modify or Withdraw an existing structure component.
4. Save your modifications to the business object.
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Set Status on Changes

The list of default statuses that can be set from the Change Status button on changes depends on the workflow
definition. The workflow in Product Development always has an Approval status.

- Approval: Select this status when you create the change order or change request and want to send it to
reviewers for their review and approval or return.

- Hold: Select this status when the change must be withdrawn from active evaluation and review.

- Cancel: Select this status if you must delete the change order.

Related Topics
« Overview of Change Orders and Change Requests

« View Affected Objects and Change Operations

Create a Change Order and Submit it for Approval

Changes are created to modify an item. Use the Product Development work area to create a change order and submit it
for approval.

Create a Change Order from Scratch

Use the Navigator to go to the Product Development work area.

Open the Tasks panel tab.

Click Change Order > Create Change Order.

From the Create Change Order window, select one of the predefined change types.
In the Name field, enter a name for the change order.

In the Description field, enter a brief description of the change order.

CUuPAUNA

Note: The Create dialog box also shows the required extensible flexfields as well as the ones configured in
number assignment rules for the selected change type. For more information on number assignment rules,
see the related links.

Click Save and Close.

Click the Affected Objects tab and then click Add Item.

Search for an item and click Add to add it to the list of affected objects.

10. Click Save. By default, the change order is in Draft status.

11. Click the Change Status button to move the Change Order from Draft status to Open status.
12. Click the Approval option in the Change Status list to submit the Change Order for approval.
13. Add Approvers, as needed, and click Submit.

0 0N

You can enter other information to the new change or save it and later add more information.

Create a Change Order by Copying an Existing Change Order

From the Actions menu in a change order, use Save As to create a new change order of the same type or a different
type. Here's what you can copy over from the existing change order: descriptive and extensible flexfields, attachments,
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affected objects, and relationships. Note that you can copy relationships only in engineering change orders and change
orders without revision control.

Create a Change Order from a Change Request

From the Actions menu in a change request, use Create Change Order. Here's what you can copy over from a change
request: affected objects, flexfields and extensible flexfields of affected objects, attachments, and relationships.

Related Topics
» Overview of Change Orders and Change Requests

 Define a Change Order
« Why am | unable to create a change order?
» Rules and Rule Sets

Manage Change Orders and Change Requests

You can search for and perform actions on changes using the Manage Change Orders and Manage Change Requests
pages.

You can filter changes based on type and use other criteria to narrow your search results to the most relevant results.
You can also use the Add Fields button to add more fields to the search criteria. The fields you add can be configured to
appear as columns in search results.

Note: To configure the fields appearing in search results, click View > Show more columns.

Here are some actions you can perform from the Manage Change Orders and Manage Change Requests pages:
- Add new change orders or duplicate existing ones.

Delete change orders by adding them to a delete group. You can delete change orders that are in the Draft
status. You can delete change orders that are in the Canceled status too, but a canceled change order with even
one scheduled or completed line can’t be deleted.

Manage the change order workflow by using change order actions: Promote, Demote, Hold, Release Hold, and
Cancel.

- Generate change order details report.

If you opt in to the feature Use Extensible Flexfields on Changes, Problem Reports and Corrective Actions, here’s what
you must know:

- Search Filter
You can use this filter to search by a change type. The default search filter is set to All Change Types.
- Saved Search
The default saved search is titled Application Default. This is executed when you select a change type.
Any saved search that was created prior to opting in to the feature must be recreated after you opt in.

Manage Watchlist
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Use the Watchlist to track important business objects. The watchlist is categorized by the functional areas.
Each item on the Watchlist page is made up of descriptive text followed by a count. Click the watchlist item to
navigate to the object of interest.

You can create your own watchlist items based on saved searches. Click the Manage Watchlist icon on the
Manage Change Orders or Manage Change Request page. In the Manage Watchlist dialog box, select the check
box Include Saved Searches to add the saved searches to the watchlist.

You can use the Watchlist page in the Set Preferences work area (Navigator > Tools > Set Preferences) to
determine which categories and items to show or hide in the watchlist.

You can create watchlists for corrective actions and problem reports.
Add Fields
You can add extensible flexfields to the search criteria using the Add Fields button.

Search for Change Requests
When you search for the Change Request change type, the search results also include deviation requests.

Related Topics
« Using Common Features Guide

« Implementation Reference Guide

View and Edit Change Details

A change order's General Information side tab is the starting point to access its basic information.

Here are some side tabs available on change orders (and change requests).

General Information - the default or cover page of a change order.
Affected Objects - items or documents that are the subject of the proposed change or modification.

Attachments - text or graphic files, or URL, with more information about the change order; attachments are
classified in a category.

Workflow - the sequence of statuses through which the change order advances.

Impact Analysis - impacted assemblies are those that are impacted by modifications to items or structures on
this change order.

Relationships - association between change order and another business object.
Security - add team members to the change order; search and select by Person (user name) or by Role.

When the role is expanded into a comma separated list, the number of characters in the list should not exceed
2000.

History - a table showing the sequence of actions performed on the change order.
The Comment column in the history table shows additional information about an action.
The Author column shows System when an action is performed by the application.

7
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It shows the user name when the action is performed by a user.

The table shows some of the actions performed by the application, and the entries in the Comment and Author
columns:

Actions Comment Author
System Items effective on approval: <items> System
System Can't be promoted System
System Autopromote from <old status name> statusto =~ System

<new status>

The table shows some of the actions performed by the user, and the entries in the Comment and Author columns:

Actions Comment Author

Created Through item batch: Name: <batch name>, <user name>
<batch number>

Created Through item batch ID: <ID> <user name>
Note that this comment appears when the
change is created through FBDI.

Promoted to approval <comments entered by the user when <user name>
promoting the change for approval>

Content Presence Indicators
When you open a change order, you can view blue side tabs, indicating the presence of content in them.

Icons for tabs that always have content or have content that is calculated upon selection are always gray in color. They
include the General Information, Workflow, History, and ltem Grade tabs.

General Information Tab

When you open a change order, the General Information tab is displayed. You can fill in attributes for the change order.
The change order number can be filled in during creation, or, depending on the configuration, it can be automatically
generated.

This tab can also include the following additional fields:

- Attributes such as descriptive and extensible flexfields set up by your administrator. Depending on the
configuration, you can enter up to 4000 characters in the descriptive flexfield.

- Trading Partner Reference attributes such as Customer, Supplier, Manufacturer, and Source are associated to
changes such as change orders, change requests, problem reports, and corrective actions. These attributes also
appear for supplier portal users.
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Note:
Change types that are created based on a predefined change type inherit the attribute visibility configuration of
the parent change type.

Use the Manage Change Header Attributes action in Additional Workflow Controls to allow or disallow
participants from modifying the general information.

- Affected objects in engineering change orders and change orders without revision control can include
engineering objects.

- Affected objects in commercialization change orders can include engineering objects that are ahead of the
design lifecycle phase, and non-engineering objects.

Attachments Tab

Click the Attachments side tab, the Attachments page displays. Files can be associated with this change order using the
+ Add icon or Actions > Add. If you select a listed attachment, the X Delete icon and Actions > Delete are enabled.

When you want to modify an attachment, you must first distinguish the purpose and place where the attachment
appears. An attachment on a change order is a document that further explains something about the change order itself.
This attachment can be modified directly, as long as the change order is in an editable status; there's no need for an
additional change order.

Attachments on items are managed with the mechanism of a change order, in which proposed modifications to the
attachment are described, reviewed, and approved, much like proposed modifications to the item's design or attributes.

Related Topics
« Secure Access to Changes

« Terminate and Restart a Workflow
« Replace a Component
« Configure Change Types

Edit Released Engineering ltems

You can edit released engineering items by assigning them to a change order or using change order import. To modify
the entire structure that contains the released item, you must also assign the parent item.

If you're using change order import, you can modify the following: item general information, structure components,
reference designators, substitute components, and AML. This isn't applicable for commercial items and
commercialization change orders. For more information, see the related topic on Iltem Batch Change Order Options.

Before you edit released engineering items, note that:

- You don’t have to route the items through a change order if you're modifying the following:
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o Preliminary engineering items that have never been added to a change order.

For example, you can modify the AML through import map without a change order, if the item hasn’t
been assigned to any change order.
o Item extensible flexfields and operational attributes that aren't change-controlled.

o Attachments on the item.

- You must use a change order to modify released engineering items or structures through FBDI also.

- To avoid enforcing change control during migration or mass update, set the profile option
EGP_CONVERSION_MODE to Yes. Remember to set it back to No after the process is complete.

Related Topics
« Item Batch Change Order Options

Modify Assignee

If your workflow is stuck due to absence of the assignee, you can modify both assignee role and default assignee.

You can modify these fields on the following objects: change orders, change requests, problem reports, and corrective
actions if they're stuck.

Before you modify the assignee role or the assignee, here's what you need to know:

It's recommended that you always populate the Assignee Role field on the General Information tab so that the
Assigned To user can add approvers during the approval workflow.

- The Assignee Role field can be edited in the Draft and Open statuses. If the object is in interim or approval
status, you must terminate the workflow.

- To modify the Assignee Role and Assigned To fields, you must have the Manage Assignee privilege. You must
also have permission to manage change header attributes as defined in the Additional Workflow Controls table
in change type setup.

If the assignee role isn't defined, the new assignee must have the BPMWorkflowAdmin privilege to terminate
the workflow and reassign.

If the assignee role isn't defined and the new assignee wants to reassign or delegate a task from BPM
Worklist, the new assignee must have the BPMWorkflowSCMAdmin privilege to view all the approval tasks in
Administrative Tasks.

- You can't edit the Assignee Role or Assigned To fields for objects that were added prior to the support of
Additional Controls in update 20B.

- Only the Assigned To user can see the Terminate and Restart actions in the Actions menu. Ensure that a user
name is provided in the Assigned To field.

Note: If you have modified the assignee's user name during a change order or new item request workflow, an error
message appears. To resolve the error, terminate and restart the workflow.

Related Topics
» Configure Default Assignee for Quality Issues and Actions
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Take Action on Changes

Here are some of the actions available on the Actions menu of a change in the Product Development work area:

- Change Order Details Report: generate a report of the change order. You can choose a template, format, and
locale. To generate this report, you must have the following roles:

Bl Consumer and EGO_GENERATE_ITEM_CHANGE_ORDER_REPORT_PRIV_OBI.

Note: If the column width in a multi-row table on the report exceeds the page width, the content is truncated
in the PDF format. It's recommended to use the HTML format in such cases.

- Delete: mark the change order for deletion and add it to a delete group.

You can create a new delete group or add the change order to an existing group. Note that you must perform
this action from the Product Information Management work area.

You must then confirm the deletion using Manage Delete Group available in the Tasks panel. The change order
must meet the deletion constraints so that the affected object isn't used in any other structure.

In case you want to again use the change order and it can't be deleted due to constraints, you can restore
the change order using Actions > Delete on the Edit Delete Group page. For more information, see Group
Deletions of Items, Structures, New Item Requests, and Change Orders.

- Send Object: works for items, documents, and change orders. A message about the business object is sent to
another user.

Messages displaying the list of recipients can be sent to a single user or multiple users. If there's a need to
restrict a user from viewing the recipient list, it's recommended to send notifications to a single user.

- Audit: create an audit report on a change order. Select Audit, and select a status from the fly-out list. This
generates the audit. (Which statuses are displayed depends on workflow definition.) Now, click the Audit
Results side tab. The audit checks for any problem or violation of the entry or exit criteria on the Status
changes in the workflow of the change order. The Audit Results lists all these as well as more general issues
with the change order.

- Download Attachments: appears on the list when this change order has one or more attachments. Selecting
the action opens a dialog box. You can choose from options and specify which attachments you want to include
in your download.

- Publish: publish engineering change orders to an XML report. A process ID is generated for each report. To
view the report, click Tasks > View Scheduled Process and enter the process ID.

- Move Change Lines: move the selected affected objects to a new change order within the same organization.

- View Reports: view and launch preconfigured reports for change orders.
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Related Topics
- View and Edit Change Details

« Move Change Lines

- Cancel Change Lines

« Replace a Component

« Where can | approve or reject a change order?

- Manage Attachments in Items and Change Orders

Add or Remove Participants from Future Status

You can add or remove participants from a future status in the workflow when the change is in draft, open, interim
approval, approval, or scheduled status. Note that this depends on the permissions assigned in the additional workflow
controls table.

Your participants include reviewers, approvers, and optional approvers.
To add participants to a future status, you must select the future status in the workflow and click Add in the Participants

section.

Note:
- Your participants receive notifications which can be configured by your administrator.

- A Claim button appears on the approval notification when multiple reviewers are added. If one of the reviewers
claims the task, the others don't see any action buttons on the notification.

Current Change Status For Future Approval Status For Future Scheduled Status For Future Completed Status
Open Add or remove users and roles Add or remove users and roles Add or remove users and roles
such as approvers, optional such as reviewers. such as reviewers.

approvers, and reviewers.

Approval N/A Add users and roles such as Add users and roles such as
reviewers. reviewers.

Related Topics
« Actions You Can Control

Add or Remove Participants in Current Status

You can add or remove approvers in the interim approval and approval status. You can add or remove participants of
type reviewers when the change is in draft, open, approval and interim approval, scheduled, or completed statuses.
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Note:
- Participants include reviewers, approvers, and optional approvers.

- This is applicable for change orders, change requests, problem reports, and corrective actions.

- Adding participants depends on the permissions assigned in the additional workflow controls table.

Here are some additional details:

- The newly added participants receive notifications. You're restricted from adding a role that has more than 40
members to the approval workflow if the Response Required From field is set to All. This happens when you
promote the change. Also, automatic promotion is prevented. You'll see a new entry in the action log and a
notification is sent to the analyst.

- Optional approvers can't be added when approval is in progress.
- Only the change analyst can remove approvers or reviewers in the current approval status.

- You can't add a role as an approver and a reviewer in the current interim approval or approval status. You can
only add individual users.

- You can't remove the role.
- You can't remove approvers who have already approved or rejected the change.

- You receive an FYI notification if you're removed as an approver or reviewer in the current interim approval or
approval status, and if you're removed from the approval group.

o You can see the comments provided during the removal action in the notification.

Note:
o In BPM Worklist configuration, it's recommended that you make commenting mandatory when
rejecting a change order so that rejection comments are captured.
o Comments are visible in the rejection notification for change orders, change requests, problem
reports, and corrective actions.
Related Topics

- Why am | unable to add or remove approvers during the change order approval?
» Actions You Can Control
- View Product Management Notifications

Cancel Change Lines

If a change order is stuck due to an unforeseen reason, review the details in the History and Workflow tabs. Depending
on the workflow, you can cancel the change order or change lines (or affected objects).

Here are some things you need to know before you cancel change orders and change lines:
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Manually Cancel the Change Order

Use the Cancel Change Order action. Then the application cancels all change lines except the ones that are complete;
the change order status is set to Canceled.

Note: To cancel a change order in the interim approval or approval status, you need the reschedule change order
privilege.

Manually Cancel the Change Line

Use the Cancel action.

If you cancel change lines in a Scheduled change order which is stuck because the effectuation post process job is stuck,
a message appears that the change line is implemented and the line will be set as Completed, not Canceled. An entry is
made in the change history and an FYI notification is sent.

Auto Cancellation of the Change Line

If the application detects an error when implementing or activating the change line, the change line gets canceled
automatically. If this happens you notice:
- an entry in the History tab indicating which change line is automatically canceled.

- the change line status appears as Canceled.

To proceed with the change line, you can move it to another change order.

Factors that Determine Whether you Can Cancel Change Lines

The following factors determine whether you can cancel change lines or not.

- the header status in a change order
- the progress on the header status.

If you aren’t the analyst (assignee), you must be assigned with the BPMWorkflowScmAdmin privilege,
regardless of the permissions defined in the additional workflow controls table.

Note: If you modify the assignee, you must assign the BPMWorkflowScmAdmin privilege to the new
assignee.
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Edit BAT_PD_CO_TYPE: Test_change_orders (2811) 2

Workflow

Draft
o 0gress

1 Open

Workflow  ummary

= No data to Bsplay.

-

» Not Start »

Not started - Indicates
progress on the

status

Affected Objects

Draft - Indicates header

header status

Actions w Vieww [ i Move Change Lines [y
=2
Line Number Class Name Description  Status
e 10 @@ Root tem Class tHow1 TestNov1

Ff)raﬂ - Indicates change line (or affected object) status |

When Can | Cancel Change Lines?

The table shows the criteria to cancel change lines:

Header Status Progress on the Header Status Change Line Status

Draft Draft Draft

Cancel Cancel Cancel

Open Open Open

Open Open Hold

Open Open Canceled (one line canceled)

Interim Approval

Interim Approval

Submitted for Approval

Cancel Change Lines?

Yes

Not applicable

Yes

Yes

Not applicable

Yes

ORACLE

79



Oracle Fusion Cloud SCM
Using Product Development

Header Status

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Approval

Approval

Approval

Approval

Approval

Approval

Scheduled

Scheduled

Scheduled

Completed

Completed

Completed

Interim Approval

Interim Approval

Approval

Approval
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Progress on the Header Status

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Approval

Approval

Approval

Approval

Approval

Approval

Scheduled

Scheduled

Scheduled

Completed

Completed

Completed

Failed

Failed

Failed

Failed

Change Line Status

Approved

Rejected

Terminated workflow

Terminated Hold

Canceled (one line canceled)

Submitted for Approval

Approved

Rejected

Terminated workflow

Terminated Hold

Canceled (one line canceled)

Scheduled

Failed

Canceled (one line canceled)

Failed

Canceled

Completed

Approved

Submitted for Approval

Submitted for Approval

Approved
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Cancel Change Lines?

Yes

Yes

Yes

Yes

Not applicable

Yes

Yes

Yes

Yes

Yes

Not applicable

Yes

Yes

Not applicable

No

No

No

Yes

Yes

Yes

Yes
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Header Status

Open

Interim Approval
Approval
Scheduled

Completed

Related Topics

Progress on the Header Status

Canceled

Canceled

Canceled

Canceled

Canceled

Change Line Status

Canceled (all lines canceled)

Canceled (all lines canceled)

Canceled (all lines canceled)

Canceled (all lines canceled)

Canceled (all lines canceled)

- Why did the Scheduled change order get promoted automatically?

Move Change Lines

Here are a few scenarios in which you can move change lines or affected objects:

Chapter 8
Change Management

Cancel Change Lines?
Not applicable
Not applicable
Not applicable
Not applicable

Not applicable

- The change order is stuck. Depending on the header status, you can move the change line to a new change
order and proceed with the change.

- The change order is automatically canceled. Depending on the header status, you can still move the lines to a

new change order.

Here are the factors that determine whether you can move change lines:

- The header status in a change order.

- The progress on the header status.

- The configuration for the move change lines action in Additional Workflow Controls for the change type.

If you're on update 21C or later, note that this action isn't controlled by the Reschedule Item Change Order

privilege.

The images show where the header status and the progress status are displayed:
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Edit BAT_PD_CO_TYPE: Test_change_orders (2811)

Workflow

1 Open

Draft (1
© R » Not Start >

InProgress

Workflow = ummary

= No data to Bsplay.

- Not started - Indicates
progress on the

Draft - Indicates header header status
status

Affected Objects
Actions w Vieww [ i (7] Move Change Lines [y
?’,
Line Number Class Name

Description | Status

e 10 @ Root hem Class

TestNov1 Draft

Ff)mﬂ - Indicates change line (or affected object) status

When Can | Move Change Lines?

The table shows the criteria for moving change lines:

Header Status Progress on the Header Status Change Line Status

Draft Draft Draft

Cancel Cancel Cancel

Open Open Open

Open Open Hold

Open Open Canceled (one line canceled)

Interim Approval

Interim Approval

Submitted for Approval

Move Change Lines?

Yes

Yes

Yes

No

Yes

Yes
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Header Status

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Approval

Approval

Approval

Approval

Approval

Approval

Scheduled

Scheduled

Scheduled

Completed

Completed

Completed

Interim Approval

Interim Approval

Approval

Approval
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Progress on the Header Status

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Interim Approval

Approval

Approval

Approval

Approval

Approval

Approval

Scheduled

Scheduled

Scheduled

Completed

Completed

Completed

Failed

Failed

Failed

Failed

Change Line Status

Approved

Rejected

Terminated workflow

Terminated Hold

Canceled (one line canceled)

Submitted for Approval

Approved

Rejected

Terminated workflow

Terminated Hold

Canceled (one line canceled)

Scheduled

Failed

Canceled (one line canceled)

Failed

Canceled

Completed

Approved

Submitted for Approval

Submitted for Approval

Approved
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Move Change Lines?

No

No

Yes

No

Yes

No

No

No

No

No

Yes

No

Not applicable

Yes

No

Yes

No

No

No

No

No
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Header Status Progress on the Header Status Change Line Status Move Change Lines?
Open Canceled Canceled (all lines canceled) Yes
Interim Approval Canceled Canceled (all lines canceled) Yes
Approval Canceled Canceled (all lines canceled) Yes
Scheduled Canceled Canceled (all lines canceled) Yes
Completed Canceled Canceled (all lines canceled) Yes

Move Duplicate Change Lines

Here are some guidelines before you move duplicate change lines:

- If you need to move two or more duplicate change lines from one change order to another, you must select all
lines and move them in a single action. You can't move such lines one at a time.

- If a change line is canceled in the target change order, then you can't move the same item again as a change
line to the target change order. You must remove the canceled change line or move it to a different change
order before you move the same item to the target change order.

Related Topics
« Actions You Can Control

Understand Role Expansion in Change Orders

In the change order's Approvers table, roles are expanded to show all members of the role only in certain cases.

- If the approver is a role and Response Required From is set to All, the role is expanded to show all its
members.

- If the change is promoted to approval and the role has more than 40 members, it won'’t be expanded. You must
delete the role to submit the change for approval.

- If only one response is required on a user-defined approval and roles have been added as approvers, the roles
aren't expanded to show their members.

In either case, all members of the role receive notifications on completion of the change workflow, and you can track
who signed off. Note that the Assignee field in the notification is also not expanded to show all role members.

Edit Reference Designators on Changes

You can enter reference designators directly inline on the structure tab of the affected object, or in the side panel view.
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If your implementor has configured a range indicator for reference designators, you can enter a reference designator
range instead of entering each value.

Here's how you edit reference designators:

1. Navigate to the structure tab of the affected object on a change order.
2. Select the component for which you want to add or edit reference designators.
3. Edit reference designators directly in the Reference Designator column.

Here's what you need to know:

o To enter multiple values, use a comma-separated list of values, or a range, or a mix of both. For example,
if your administrator has selected '+' as the range indicator, you can enter 'A1+A5' and the application will
expand the range to create five reference designators: A1, A2, A3, A4, and A5.

o You can click the expansion button "..."' next to the reference designator cell to open a dialog box where
you can view and edit the expanded values for the reference designators. The expansion button is only
available for the row that's being edited. You can also enable or disable the quantity check and align
quantity from this dialog box.

o Use the drop-down list in the side panel to filter reference designator redlines. It includes the following
options: All, Added, Deleted, Modified or Unchanged. By default, All is selected.

o You can't edit the reference designators in the side panel, you can only edit the descriptive flexfields.
4. C(lick Save.

Manage Tasks in Change Orders and Change Requests

You can create a checklist of tasks related to the change order (or change request) and assign work to individuals.

You can make it compulsory for certain tasks to be completed by specified users before the change order can progress
to a status.

Here are some more details on tasks:

- Your ability to manage tasks depends on the permissions for the Add Tasks, Remove Tasks, and Update Tasks
actions in Additional Workflow Controls for the change type.

- You can mark the status of a task and assign tasks even after the change order is complete. Use this to manage
post-completion tasks such as documentation or qualification of contract manufacturers. Note that only the
change assignee can manage tasks in Completed status.

- The task can't be set as required if the Complete Before Status is one of the following: blank, first Open status,
Scheduled, or Completed.

Note: Status first Open indicates the first open status in case your administrator has configured additional
open statuses.

Here are some examples of tasks:
Prepare Functional Specification document.
Review and update cost attributes of affected objects.

Define regulatory attributes.

Publish information to Marketing and Sales.
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The Tasks table includes the following fields that let you specify task details:

- Sequence: Determines the order in which the tasks are performed. By default, this increments by 10.

- Required: Indicates that the task is compulsory for the change order to progress. If a task is compulsory, then a
Complete-Before Status must be specified.

- Assigned To: Specifies the person to whom the task is assigned.
- Assigned By: Specifies the user who assigned the task.
- Assigned On: The date and time when the task was assigned.
Note: If the same task has been assigned by different users, the Assigned By and Assigned On fields show details of

the latest assignment.

- Start-by Status: The status at which the tasks should be initiated. Includes current and future statuses, and a
blank value. Use the blank value when you want the task to being irrespective of the change status.

- Complete-Before Status: The status before which the task should be completed. Includes future statuses and
a blank value. Use the blank value to leave this field blank when Start-by Status is set to Completed.

- Need-by-Date: Indicates the date on which the tasks should be completed.

- Task Status: Can be updated only by the task assignee or the change analyst.

Copy Existing Tasks to New Change Orders

You can create a new change order based on an existing one, and copy over the tasks. Use the Save As action (in the
change order). Tasks in the newly created change order are reset to the Open state.

Related Topics
-« Why am | unable to update the task status in the change order?

- Understand Change Order Statuses

Secure Access to Changes

To secure a change order (or change request) from unauthorized access, you can add the users or roles who should
have access to it.

To add users or roles:

- Click the Security tab in a change order.
From Actions, click Add.
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Note:
If you're unable to add users, you must review privileges assigned to your role or create a data security policy
for change orders. For more information, see related topics.

- You can also secure extensible flexfields appearing on the change order. For more information see the related
topics.

Users in the Product Development and Product Information Management work area can view and approve change
orders, whereas users in the supplier organization can only view and publish change orders.

Here are some things you need to know about a new change order:

Until you restrict access, change orders can be accessed by all users including supplier portal users.

If a new user or group is added to restrict access, the change order creator and assignee are added
automatically.

- Toremove the creator and assignee, use the Delete All option.

To enable users to view or approve change orders, an administrator must also provide the necessary privileges.

When you search for a change order using any criteria, the search results show only the change orders that you're
allowed to view.

Track Modifications Made to the Security Tab

You can also track modifications made to the Security tab of a change order (or change request) by using the View Item
Audit Trail report. Use the report to see who added or deleted entries in the list of users and roles.

1. From the Tasks panel tab, click View Item Audit Trail.
2. On the Audit Reports page, select the search criteria:

o In Product, select Product Hub.
o In Business Object Type, select Change Object Security.
o Click Search.

Related Topics
« Troubleshoot Issues in Change Objects

« Secure Extensible Flexfields on Change Types

Impact Analysis in Change Orders

You can launch an impact analysis from the Impact Analysis side tab on a change order or change request.
Start the impact analysis from an impacted product. Use either of the following:
From the Impacted Product panel look into the details for a specific impacted product.
Filter the multilevel item structure of the product, to see only that part of the item structure that is impacted by

the change. Thus, it is easier to focus on the relevant part of a larger item or document structure.
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- Go to the Affected Object panel, select a specific affected object, and start an impact analysis from the toolbar
icon or Actions menu.

View the list of impacted products, and analyze why the product is impacted. Understand how many affected objects
impact the product. Adapt the change definition to achieve the intended list of impacted products. The impact analysis
opens the affected assembly and displays where the modified object exists in the impacted structure. The change order
originator and reviewers may use this impact information for decisions about the proposed changes.

Change Order Notifications

Notifications are sent to assignees throughout the lifecycle of the change order.

For a detailed list of new item request notifications, notification types, and recipients, refer to View Product
Management Notifications available on the Oracle Help Center.

Here's when the notifications are sent:
- When a change order is submitted, notifications are sent out to assignees, approvers, and the requester.
- When you start a step, notifications are sent to each of the assignees of the step.

- When the change order is approved or rejected, a notification is sent to the creator, and approver.

Notifications are of the following types:
- Task notifications are sent out to the assignees of each task.

- FYI notifications are sent to the creator, assignee, requester, and approver of change order lines and headers
when it moves to Scheduled or Completed Status.

Important Considerations about Notifications:

- FYI notification is sent if you're removed as an approver or reviewer for the change that is in the current interim
approval or approval workflow status.

- FYI notifications are sent to all the removed participants of the approval groups.

- FYI notification shows who has rejected the change order approval request and the rejection comments for the
same.

- Comments are visible in the rejection notification for change orders, change requests, problem reports, and
corrective actions.

You can see the comments provided when you are removed as a workflow participant.
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Note:

Note:

If the approval notifications are delayed ensure that approvers have the following role:
EGO_GENERATE_ITEM_CHANGE_ORDER_REPORT_PRIV_OBI

The assignee in the notification refers to the users who are part of the approval groups. If your role is
designated as the workflow status participant, the Assignee field of the FYI notifications displays your role,
instead of your user name.

Sometimes, unanticipated issues prevent the workflow from getting completed as expected, and terminating
a workflow maybe inevitable. You can stop an approval routing workflow, even if it isn't completed using
Terminate Workflow. Related notifications, if any, are removed from the assignees' work lists.

In BPM worklist configuration, it's recommended that you make commenting mandatory when rejecting a
change order so that the rejection comments are captured.

Workflow participants (approvers, optional approvers, and reviewers) don't receive FYI notifications for change
workflow events that aren't relevant to them.

Only participants added to the current and previous workflow statuses receive notifications when:

o The change is rejected or completed.

o Autopromotion fails.

Participants added to future workflow statuses or skipped workflow statuses don't receive FYI notifications for
these events.

If the change moves through a status and is demoted, participants of the status through which the change
moved will receive a relevant FYI notification.
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Note:
- The number of affected objects displayed in an email notification depends on a threshold.

If the number of objects exceeds this threshold, a link to the change order page is provided so that you can
navigate to the object and view the full list.

For change order approval task notifications, the threshold is 25.

For FYI notifications, the threshold is 100.

- A predefined request comment notification is associated with the Open status. The change order can't move to
the next status until this notification has a response. The notification is then sent automatically to the assignee
and the requester.

This automatic notification can be bypassed by removing the assignees. If the notification is bypassed and the
BPEL process is set to automatically promote, then the change order automatically moves to the next status.
Otherwise, you need to manually move the change order to the next status.

- Change order notifications aren't sent for the following actions:
o Skip Current Assignment

o Suspend

o Create Subtask

o Request Information
o Route Task

o Add Comments

Related Topics
« What Change Orders Modify

- Understand Change Order Statuses
« View Change Order Notifications
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Publish Change Orders

Publication enables you to schedule and publish engineering change orders.

You can publish engineering change orders as an XML package. Use filters to select the type of change data you want to
publish, including attachment files.

Note: You can retrieve the publication files from Oracle WebCenter Content programmatically, or by using the File
Import and Export option available in Tools of the Navigator.

Here's how you publish an engineering change order:

1. Inthe Product Development work area, select an engineering change order in the Completed status.

2. Open the change order that you want to publish. Click Actions > Publish. You can also choose the publication
action from the Manage Change Orders page.

3. Select the entities that you want to publish in the Change Publication Criteria box. You can choose either some
or all the entities from the list.

o Affected objects

o Header attachments

o Affected object redlines only
o Affected object attachments
o Affected object structures

o Affected object AML

Note: The Include attachment files check box is enabled only when you select an entity that includes
attachment.

Click Publish. A confirmation box is displayed with the process number.
To see the report, click Tasks > View Scheduled Process.
Enter the Process Id in the View Scheduled Processes window.

Click View Output to download the published engineering change order. The output is available in a zip file
format. Click the file to download it.

No vk

Note: You can automate the publishing of engineering change orders using SOAP web services. You can also use the
ltem Publication event - PublicationJobCompleted to determine if a change order is published and automate the
additional steps.

Related Topics
« Refer to support note: Doc ID 13344711 Sample Soap Requests for Use in WebCenter Content (WCC/UCM) 11g
Calls to the GenericSoapService

- Refer to support note: Doc ID 2885473.1 Invoke, monitor and download the change order publication using
SOAP Web services
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View Published Change Order Reports

You can access the published file in XML format from the Oracle WebCenter Content.

Publication files for change orders are published to the FAlmportExport Security Group root folder in Oracle WebCenter
Content instead of the Contribution Folders location to avoid any limitation in the number of files that can be stored.

Use a Change Order to Redline an Item Structure

Redlining is the process of marking modifications to an item or structure that must be approved to be implemented.
This topic describes how to use a change order to redline an item structure.

To use a change order to redline an item structure:

1. Use Navigator to go to the Product Development work area.
2. From the Tasks panel tab, click Create Change Orders.

o From the Change Type list, select a type of change order.
o Inthe Name field, enter a name for the change order.
o Inthe Description field, enter a brief description.
o Click Save and Close.
3. Click the Affected Objects side tab.

o On the change order, click Select and Add to search for and add the affected object so that you mark it
for modification.

o Go to the Structure tab. From the results, select an item row.
o Go to the X icon and select Withdraw to withdraw the item from the structure.
o Click OK.

4. Now you must add a new item to the Structure.

o Click the Create icon.

o Select a class from the Class list.

o Inthe dialog, enter a name in the Name field.
o Enter a description in the Description field.

o Click Save and Close.

You can view the saved modifications in the summary of changes.

Related Topics
- Watch Video: Use a Change Order to Redline an Item Structure
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Use a Change Order to Add a Manufacturer Part to an
ltem

This procedure creates a change order, adds an item, and associates the item with a manufacturer part.

1. Use Navigator to go to the Product Management work area. From the list of offerings, click Product
Development.

2. Create a change order, using the following steps:
o From the Tasks panel tab, click Create Change Order.
o Inthe Create Change Order dialog, select a change type. Click Save and Close.
o Enter the following details for the change order: number, name, and description.
o Select the priority.
o Click Save and Close.

3. Add the item as an affected object to the change order, using the following steps:

o Click the Affected Objects side tab and click Select and Add.
o Enter the item name and click Add.

4. After the item is added as an affected object, select the item and click Edit Affected Object.
5. Edit the item to add the manufacturer part, using the following steps:

o On the Edit Item page, click AML.
o Click Select and Add to add the manufacturer part as a recommendation.

o Select the manufacturer name, part number, status, and context. Click OK.

The manufacturer part is highlighted and includes a plus icon to indicate that it's a new assignment.

Note: The change order must be approved for the manufacturer part to be implemented.

o Click Save and Close.

Related Topics
» Watch Video: Use a Change Order to Add a Manufacturer Part to an Item

How Application Validates Change Assignee
When you promote or demote a change order (or change request) to the next status, an additional check validates
whether the assignee is an active user. This check is performed for each status up to Approval status.

If the assignee isn't an active user, the promotion doesn't proceed. Demotion will proceed, and an entry is added in the
action log.
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During manual or automatic promotion to Open status, if the application detects that the person who initially requested
the change is an inactive user, the change isn't promoted.

During demotion, if the assignee is found to be an inactive user and Skip Request Comment is disabled, the Request for
Comment notification isn't sent. A corresponding entry is created in the action log. In this case, the user must choose an
active user as the assignee and then promote the change manually.

How Revision is Calculated for Engineering Change
Orders

Here's how the next higher item revision number in an engineering change order is calculated.

In releases prior to 20D, only the past, current effective, or future effective (change order is scheduled) revisions were
considered.

From release 20D onward, all revisions (past, current effective, future effective, and pending) are considered when
searching for the highest existing revision number. Instead of retrieving the item revision with the furthest future
effectivity date, the application retrieves the item revision that was created most recently.

Here's how this impacts application behavior (from release 20D onward):

- Theitem revision identified as the base revision for new revision calculation changes because the application
evaluates the creation date of the item revision instead of the effective date. In case the calculated item revision
is already used, the application doesn't blank out the item revision number, but continues to increment the new
item revision number until it finds an unused number, so the user doesn't have to enter a number manually.

- The algorithm to calculate the next higher revision number supports up to 18 characters.

Note: When you add an item as an affected object to a change order, its revision is automatically bumped up. But
revision field remains blank when the bump-up mechanism fails to calculate the next higher revision in the following
actions: Assign to Change Order on an item, and Save As on a change order for creating an engineering change order.
When you access the Attachments tab on the change order, a message informs you to specify the new revision before
you can view attachments. If you don't specify the revision, you're prompted to specify it when you promote the
change order for approval.

How Item Approval Privilege is Validated at Role Level

Make sure any role that you add as an approver, or a parent role, has the Approve Item Change Order privilege assigned.

When a role is assigned in the approvers panel of a change order (or change request), and the change

is submitted for approval, the application checks whether the Approve Item Change Order privilege
(EGO_APPROVE_ITEM_CHANGE_ORDER_PRIV) is assigned to the role (directly or through role inheritance). If it isn't, an
error is shown.
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FAQs About Change Management

How do | add an item or document as an affected object?

Open the item or document and select Assign to Change Order from the Actions menu.

What's the difference between an affected object and a change
line?
Both the terms indicate an object affected by the change order.

Affected object is used in the Product Development work area and Simplified Change Management Interface.

Change line is used in the Product Information Management work area.

How can | create a new change order based on an existing change
order?

You can use the Save As action to create a new change order. In the Create Change Order dialog box, you must select
the change type for the new change order.

Here's what you need to know before you before using the Save As action:

- Depending on the work area, you can choose to copy over the existing descriptive and extensible flexfields,
contextual attributes, attachments, tasks, and affected objects.

- In the Product Information Management work area, you can save the change order to any type of
commercialization change order.

- In the Product Development work area, you can save the change order to an engineering change order or
change order without revision control.

- To copy over the descriptive and extensible flexfields select the Additional Information option in the Save As
dialog box.

What's the difference between Withdraw and Remove?

Use Withdraw, to delete a component that was added before the item was assigned to the change order.

Use Remove, to delete a component that was added after the item was assigned to the change order.
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How can | view the list of change orders that are on hold or
canceled?

You can use OTBI to generate a report listing change orders that are on hold or canceled.

How do | add items or documents to an existing change order?

With a change order open, click the Select and Add button to add existing items or documents, or click the Create
button to add new business objects.

What's the difference between cancel and terminate actions in a
change order?

Use cancel to stop further processing of the change order. You can still move the change lines to a new change order
and retain redlines.

Use terminate to temporarily pause the workflow and resume it in the same change order.

Related Topics
« Terminate and Restart a Workflow

» Cancel Change Lines

Why am | unable to modify the change order?

The change order is in an Interim Approval status and the Allow Updates option on the Interim Approval status has
been disabled. Or, you only have privileges to view the change order.

Where can | approve or reject a change order?

Use one of the following to approve or reject the change order:

- Bellicon
- The change order page

- Home page of the Product Development work area
Select the My Changes information tile. Click Approve or Reject appearing against the change order.

- Email notification
- BPM Worklist
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You can approve multiple change orders from BPM Worklist. But the signature policy for change orders must be
disabled.

- In Things to Finish section on the home page

Related Topics
- Configure the Signature Policy for Change Order Approval

Why am | unable to edit the change order?

If the change order is created in Product Information Management, you can't edit that in Product Development.
Conversely, the change order created in Product Development can't be edited in Product Information Management.

Can | modify the find number when the item is on a change order?

You can modify the find number when the change is in draft or open status. Here’'s how:
Delete a component and add it again with a different find number.
Or

Use the Replace action to replace a component with the same component and provide a different find number.

How can | find out who acted on a change order and the changes
they made?

Open the History tab of a change order or change request to see the sequence of actions recorded for that object. You
can see who has performed each action along with the time stamp and the details about each action.

For example, you can see who approved the change order and the approval comments.

Why did the change order approval prompt for a comment and
password?

Your administrator configured the comment and password fields as compulsory for the purpose of audit. Enter your
sign-in password.
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How can | restart the change order workflow which is on hold
when the approval is in progress?

From the Actions menu, click Restart Workflow.

I Note: You can't restart the workflow using Continue.

What's the difference between an engineering change order and
change request?

Both the change types permit you to route items and documents through a workflow.

The engineering change order lets you markup the required changes and the changes become effective on approval.
But the change request doesn't provide any markup.

Why did the Scheduled change order get promoted automatically?

Since the Autocomplete on Cancel option is enabled by default from update 23A, all scheduled change orders move to
the Complete status on cancellation of the last change line. This is applicable to new and in-progress change orders.

Let's say that the first three change lines are complete, and the last change line is stuck in the Scheduled state. You
cancel the scheduled change line, and the change order moves to the Completed status.

Related Topics
« Create Problem Reports and Corrective Actions

» Understand Change Types

Why did the change order fail on approval?

Open the History tab of the change order to review the sequence of actions on that change order. Depending on the
action performed, the application displays a comment.

For example, if you try to promote two change orders simultaneously and the effective dates are less than 30 minutes
apart, then a comment appears advising you to maintain a time difference of more than 30 minutes. You can also see
the Workflow tab to review the change order status.
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Related Topics
» Cancel Change Lines

Why am | unable to add or remove approvers during the change
order approval?

You must be assigned with the add participants and remove participants actions in the additional workflow controls for
the change type.

Additionally, the value of Response Required From (in the change type) must be set to All.

Why did the change order workflow restart automatically?

If the schedule processor job is stuck in the initial run and it doesn't require any user intervention, the application
restarts the job. It restarts up to 5 times with increasing time gaps in between each job.

You don't need to manually search for unsuccessful change orders that weren't processed due to locked affected
objects.

Note: An item can be simultaneously updated from different sources. A record can be updated through the user
interface, while another update could be triggered through a web service or scheduled process. This results in locking
issues, and the jobs can't be complete successfully. In such scenarios, the application restarts the subsequent job after
some wait time and attempts to complete the job.

How can | remove a participant from the change workflow?

In the Change Status dialog box, select the participant and click Delete. You can also perform this action from the
Participants section on the change Workflow tab.

Note:

- Your ability to remove a participant depends on the permissions assigned in additional workflow controls for
the change type.

How can | do a bulk upload of change order attachments?

You can do a bulk upload of change order attachments using REST services.
Here are a few things to keep in mind:

- The change order must be in draft, open, or interim approval status, and
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In the change type, the Allow Updates option must be selected against the status.
Refer to the REST API for Oracle Fusion Cloud SCM guide for more information about using these REST APlIs.

Why am | unable to update the task status in the change order?

You can only update the status for the tasks that are assigned to you. But your change analyst can update the status for
all tasks.

How many objects can | add to a change order or new item
request?

The default limit is 50 and the maximum is 100. Your administrator can change the default limit for:
- The number of change lines or affected objects in change orders, and
- The number of items in new item requests.
Here are some additional details:
- When you exceed the limit while adding items through the user interface, an error message appears.

- When you import a large number of items in a batch, you can choose to automatically split items and create
new change orders or new item requests.

Related Topics
- Item Batch Change Order Options

« Item Batch New Iltem Request Options
 Configure the Limit for Objects in Change Orders and New Item Requests

Can | set a default priority for my change order or new item
request?

Yes. You must set the default priority for a change type or a new item request type. The priority is inherited when you
create a new change order (based on the type) or new item request.

Use the following tasks from the Product Management Offering in the Setup and Maintenance work area:

Manage Change Order Types
Manage New Item Request Type Details

To set the default priority, use the Priority field.
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What actions can | take on a change order when it's in the
Completed status?

As a change analyst, you can take the following actions when the change order is in the Completed status:

- Manage change header attachments
- Manage change header attributes

- Manage relationships

- Manage security

- Add tasks

- Remove tasks

- Update tasks

- Move change lines

Related Topics
- Move Change Lines

In a change type, can | configure additional controls for the Draft
status?

No. But you can configure additional controls for Open, Approval, Interim Approval, Scheduled, and Completed status.

Related Topics
« Control Actions by Participants

How can | know whether the entire change order (or new item
request) was rejected or if a few items were rejected?

The approval notification provides details of whether the entire change order (or new item request) was rejected, or if a
few items in the change order (or new item request) were rejected.

How can | set the reason code field on a change as a required
field?

You can opt in to the Simplified Change Management Interface feature and then use Page Composer to edit the Reason
Code field component and set it as required.
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Related Topics
- Watch Video: Use Page Composer to Modify Interface Pages

Where are the change header attributes and change descriptive
flexfield attributes displayed?

In the Product Development work area and Simplified Change Management Interface, the change header and
descriptive flexfield attributes are available on the General Information tab of the change order.

Examples of change header attributes: Number, Name, Description, and Reason Code.

How do | know whether my approval is required or optional for a
change order?

In the approval notification, the Activity Type field indicates whether you're an approver or an optional approver.

Why should | claim the change order approval?

The Claim action enables you to review and approve the change order before another user in the role attempts the
approval.

This is because your administrator assigned the change order approval to a role and set the value of Response
Required From as One. So one response from a user in the role is sufficient for approval. Note that an approval
notification is sent to all users in the role.

Can | create a change order without adding affecting objects?

Although you can create a change order without adding affected objects, you can't route it for approval. But you can
create a change request without adding affected objects and route it for approval.

Can | configure extensible flexfields for a change order?

You can configure extensible flexfields for a change type so that these fields appear at the header level on the change
order.

Related Topics
- Configure Extensible Flexfields for Change Types
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Why am | unable to edit the extensible flexfields on the change
order?

Your ability to edit flexfields depends on the following:
- You must have the Manage Change Order privilege.

Permission for the Manage Change Header Attributes action (in the additional workflow controls table) must be
set to All or Additional Information. For example, if you are the creator of the change, the Creator column for
this action must be set to All or Additional Information.

- You must be assigned both view and edit privileges on the Edit Context page.

In the Security tab of the change type, your role or user ID must be assigned the same view and edit privileges
(that was assigned on the Edit Context page). For more information, see the related topics.

Related Topics
« Secure Extensible Flexfields on Change Types
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9 Affected Objects and Redlines

View Affected Objects and Change Operations

The Affected Objects page provides the following views:

Redline Summary
Manage Affected Objects

You can toggle between the Redline Summary View and the Manage Affected Objects view.

Redline Summary View
Displays links to Affected Objects and Change Operations.

Affected Objects provides a summary of redlines for each object. For instance, when you replace a component, the
summary tab shows that the original component redlined and the replacement component in green (which is different
from the initial color).

Change Operations provides a detailed list of modifications that have been done during the progress of a change order.
If you modify both an attribute of an affected object and its structure, two change operations are displayed in this view.
Change operations are recorded on items, AMLs, structures, attachments, and reference designators.

The table shows the change operations recorded on object types.

Object Change Operations Recorded

Item and Attachment Modifications

Structure Modifications and withdrawals

Reference Designator Additions, withdrawals, and modifications.

Manage Affected Objects View

To perform an action on affected objects, select the affected objects and click the Actions drop-down list.

Note: When you update an affected object directly on the item page, a message appears informing you to use an
existing change order or create a new one to update the item.

Here are some additional details about affected objects:

- The presence of a Has Redlines icon (or a red dot icon) against an affected object indicates that the item has
redlines.
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- To filter a large list of affected objects, you can use Query by Example.

- View Scheduling and Activation Reports: You can view the process ID of the change order scheduling and
activation processes; it includes hyperlinks to reports in the first 72 hours of report generation. Later on, only
the IDs appear.

- View Additional Item Details:

In the Affected Objects table, each item appears with an information icon (orange triangle) to indicate that
additional information is available. You can click it to bring up a panel with details such as item name, class
name, description, status code, revision code, and primary UOM. You can also drill down directly to item details
using the hyperlinks in this panel without losing the change context.

Fill in Attributes:

You can quickly replicate a just-modified attribute or attributes in the Affected Objects tables on change orders,
change requests, problem reports, and corrective actions. To do so, use the following actions:

o Fill Up (Ctrl+U)
o Fill Down (Ctrl+D)

o Fill Selected (Ctrl+S)

For example, you modified the value of an attribute, but you have more items with the same attribute that need
the same change.

To populate similar changes in a consecutive range of rows, use actions Fill Up (Ctrl+U), and Fill Down (Ctrl+D).
Remember that you’ve to select the table cell and modify the value in the cell for Fill Down and Fill Up to work.

To populate changes in nonconsecutive rows, select the required rows and then select Fill Selected (Ctrl+S)
from the actions menu.

Freeze Structure Columns on Change Orders

You can select and freeze a single column or a group of columns on the change affected objects structure table. This
enables you to easily work with data in large item structures and review different parameters against the item number
while retaining the context of the frozen column. Note that you can only scroll through the columns to the right of the
frozen columns or scroll through the columns that come after the frozen columns.

You can't freeze individual columns within an attribute group (for example, Component Details, Purchasing); you must
select the complete attribute group. This is applicable on the structure view of commercial items and on the structure
view of affected objects on changes. Here's how you freeze a column:

- Click the Affected Objects tab on the change order and then click the item.

- Click the Structure tab of that item.

- Select the column you want to freeze and click Freeze.

Related Topics
- Can | edit context specific attributes (or descriptive flexfields) on a change order?

« Replace a Component
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Redlines in Change Orders

Redlines are the individual changes on items and on reference designators that display mark-up. They're indications of
recommended, modifications, additions, or deletions (withdrawals).

Any modification to a single item attribute is counted as one redline. The same is true whether you're adding or
withdrawing an element to a structure.

Any modification to an existing structure attribute counts as a single redline. So, modifying the content of the reference
designator attribute is one redline, and changing a second attribute counts as a second redline.

Redline information for item extensible flexfield attributes are shown in the Additional Information tab, next to the
Summary tab. The Additional Information tab appears only when redline information exists for extensible flexfields.

I Note: Validations aren't executed on extensible flexfield attributes that aren't redlined in a change order.

Merge Redlines Through Import

You can incorporate redlines coming in through import into existing affected items on a change order. This helps in
reducing the number of outstanding changes, stuck changes, and overall change order cycle time. This is supported for
engineering change orders and change orders without revision control.

You can import redlines and merge these with existing redlines on engineering items that are assigned to a change
order. You can do this as long as the change is in draft or open status. The following modifications can be merged:

Item general information
[tem structure components
Reference designators

- Substitute components

- AML

For more information, see the related topic.

Redlines in Multi-Row Attributes

When you delete a row in an attribute, the row is immediately removed. However after you save the changes, the row
appears as redlined.

Undo Redlines

In structures and AMLs, you can undo redlines resulting from addition, deletion, and modification of components and
manufacturers

Here's how you undo redlines in a structure.

1. Open the change order and navigate to the item structure page.
2. Select the rows in which you want to undo the redline and click Undo Redline.

An Undo icon appears against the rows you selected.
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The following screenshot shows the icon against redlines from deletion, modification, and addition:

Actions v View v + BE X 0

Change

Operation Item

nm  COMP-10004A

l"'\. &9 COMP-10001B

iy &8 COMP-10001C

Note: You can also cancel the undo redline action. Select the row in which you want to cancel the undo
action, and again click Undo Redlines.

3. Click Save.

I Note: The undo action is complete only after you click Save.

Troubleshoot Missing AML Redlines

Prior to update 23D, AML redlines weren't being captured correctly on a few change orders because the date attribute
values weren't synchronized. From update 23D onward you can run the Upgrade Product Management Data scheduled
process to resolve this issue:

To update start date values for AML, run the Upgrade Product Management Data scheduled process with the following
settings:

Upgrade Process: Execution
Functional Area: ltem Relationships
Feature: Update start dates on AML and display redlines

- Commit size: 10

To see which AMLs need to be fixed, you can run the same job with the upgrade process set as Analysis instead of
Execution.

Related Topics
- Item Batch Change Order Options
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Specify Effective Date for Affected Objects

An affected object can become effective on completion of the change order workflow, or on a future date.

Here's what you need to know about revisions in affected objects.

If an object is assigned to multiple change orders, each revision must have different effective dates. For
example,

Revision B resulting from change order BOO1, can be effective January 1.
Revision C resulting from change order CO01, can be effective January 6.

- When assigning an affected object to a change order, you select the particular revision that you want to modify,
and also enter the new revision for the modified object.

- The revision you want to modify includes either of the following:
o Revision that's currently effective. Note that you can't select a revision that's pending approval.

o Revision that's scheduled to be effective in future and resulting from a change order in the Scheduled
status.

Here’s what you need to know about the effective date:

- The effective date for the modified version must include a date that's in-between the existing effective dates.
For example, revision B can be effective January 1and revision C can be effective January 6. So the modified
version can include an effective date January 4.

- To ensure that item rules run effectively when you update rows in the affected objects table, the application
prompts you to save changes to lifecycle phase and effective dates separately.

Note: On saving the change order after first modifying lifecycle phase and then modifying the effective
date, the application prompts you to save lifecycle phase changes before saving effective date. If you first
modify effective date, the application prompts you to save effective date changes before saving lifecycle
phase changes.

- When you use the Fill Down, Fill Up, and Fill Selected functions to save effective date changes across multiple
rows, the changes are automatically saved separately. So you won't see a validation message if you modify
lifecycle phase values immediately after that.

Resolve Revision Conflicts

An affected object can be assigned to multiple change orders.

When you add an item as an affected object to a change order, its current revision appears in the Old Revision column
and you can provide the new revision in the New Revision column.

If the same item is already assigned to another change order, another revision is created in parallel. When you complete
one of the change orders, the application detects a conflict for the other change order. When this happens, you're
prompted to resolve the conflict.

Here are some examples to show you what causes revision conflicts and how to resolve them.
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Scenario 1

Let's say you've assigned the same item to two change orders, CO1and CO2.

- COtisin Open or Draft status and is set to be effective on a future date.

Old Revision is A and New Revision is B.

- CO2is set to be effective immediately.
Old Revision is A and New Revision is C.
Now you approve and complete CO2.

Later, when you complete CO1 which has its old revision set as A, the application detects a conflict because CO2 is
already effective with revision as C. A message appears asking you whether you want to change the old revision value.

If you click Yes, CO1is put on hold and a batch job is created to correct the revision. On successful completion of the job,
the initial revision on CO1is changed to C, hold on CO1is removed, and you can then promote CO1.

Here's an image that shows old and new revisions before you resolve revision conflicts.

Affected Objects
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Line Number Old Revision New Revision
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Here's an image that shows old and new revisions after you resolve revision conflicts.

Affected Objects
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The flowchart shows how revision conflicts are resolved when one of the change orders is in open or draft status:
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Scenario 2

Let's say you've assigned the same item to two change orders, CO1and CO2.

- COtisin Approval or Interim approval status and is set to be effective on a future date.

Old Revision is A and New Revision is B.
- CO2is set to be effective immediately.
Old Revision is A and New Revision is C. Now you approve and complete CO2.

Later, when you complete CO1which has its old revision set as A, the application detects a conflict because CO2 is
already effective with revision as C. A message appears informing you to demote the change order to open status and
resolve revision conflicts.

To demote CO1to open status, click Change Status > Open.

Note: From this step onward, the process is similar to the previous scenario.

To resolve revision conflicts:
From the Affected Objects tab on CO1, click Actions > Resolve Revision Conflicts.

Change order CO1is put on hold and a batch job is created to correct the revision. On successful completion of the job,
the initial revision on CO1is changed to C, hold on CO is removed, and you can promote CO1.

m
ORACLE



Oracle Fusion Cloud SCM Chapter 9
Using Product Development Affected Objects and Redlines

How to Resolve Conflicts Manually

Click Actions > Resolve Revision Conflicts, on the affected objects tab of the change order. Note that in the scenarios
listed in this topic, you select the change order which is open, draft, approval, or interim approval status.

What's Carried Forward in the Resolved Revision

The modifications made to AML, description and structure are carried forward from the valid old revision to the new
revision (when conflicts are resolved). Note that attachments aren't carried forward.

FAQs About Affected Objects and Redlines

How do | know whether an affected object has redlines?

Navigate to the Affected Objects tab of the change order to identify redlines.

- The presence of a Has Redlines icon (or red dot icon) against an affected object indicates that the item has
redlines.

- Click the item to open it. If any of its side tabs contain redlines, the side tab icons are highlighted for easy
reference. For example, the Structure icon changes to a Structure-Has Redlines icon with a blue highlight.

Related Topics
« View Affected Objects and Change Operations

Can | edit context specific attributes (or descriptive flexfields) on a
change order?

Yes. In the Affected Objects tab on a change order, use the Context Segment drop-down list to select the segment
configured for the change type. The configured attributes appear next to the segment.

Note: If you're a supplier portal user, you can view the context specific attributes depending on the change type
configuration.

Related Topics
« Configure Context Specific Attributes for Change Types
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10 Workflows

Workflows in Product Development

Workflows provide a mechanism to submit change orders and change requests for review and approval. You can use
workflows to manage business objects such as items and documents.

The type of the change order determines the kind of workflow. You define entry criteria for the workflow to enter a
particular status; define exit criteria for advancing the change order to the next status.

The Workflow tab in a change order documents the progress of status changes. To view the details of a status, select
the status.

The History tab records the sequence of actions performed on the change order.

After the edits are made to attributes and structure, the change order can be submitted to a formal workflow to be
approved. Once the change order is approved, the item's revision is changed according to the scheme defined by the
administrator using the system's automatic naming.

Related Topics
« Define a Workflow

« Approve or Reject a Workflow
« How can I learn of problems with the statuses in my change order's workflow?
- Why is the change order workflow status in the wrong place in the order sequence?

Define a Workflow

When the administrator defines a change type, the process includes the definition of the workflow that will be available
when you create a change order of that type.

Define the Sequence of Statuses
You can define individual status to be used in the workflow, but each status must be derived from standard Status
Types:

- Open

Interim Approval

- Approval

- Scheduled

- Completed

Every workflow has at least the following statuses by default:

- Open
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- Approval
- Scheduled
- Completed

You can define multiple status of the types Open and Interim Approval. However, the statuses of type Approval,
Scheduled, or Completed can each occur only once in a workflow.

A workflow for a change order always begins in Draft status after it has been created.

Transition of Status

To execute a status transition, use the change status option in the change order workflow.

If there is a problem in changing a workflow's status, running an Audit Report of the change order may indicate issues
with status Entry and Exit criteria.

Hold and Cancel Statuses

A workflow can be put on Hold with the Hold status option. Later this workflow could be resumed by moving it to
another status.

A workflow can be canceled with the Cancel status option. However, once the Cancel status is set, this workflow can't be
resumed.

Review the Change Order Workflow

You can use the change order workflow tab to review the workflow status, date when the status changed, and details on
approvals.

The Approvers panel shows whether the approval is assigned to a role or a user. In case of approvals assigned to a role,
the panel also shows whether the approval is required from one or all users.

Approve or Reject a Workflow

To approve or reject a change, click the Approve or Reject button on the Workflow page. You can also request more
information, reassign, escalate, or suspend the change.

Note that these buttons are displayed only if the opened change order is waiting for approval. If a change order is
eligible for approval, a task notification appears in the Worklist panel.

To view more details about the change order, open the task details from the Worklist panel.

When you request more information from a user, the user must submit the information using Actions > Submit
Information (available on the change) so that the change can be approved.

Note: If a message appears during the approval informing you that the action is invalid or the user doesn’t have
the privilege, review the change history. Identify if more information was requested from a user. The change can be
approved once the user submits the information.
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Terminate and Restart a Workflow

If an approval workflow for a change order is stuck, you can terminate and restart the workflow.

You can terminate and restart the workflow in an engineering change order, change order without revision control, and
engineering change request.

Note: Only the Assigned to user sees the terminate and restart actions in the Actions menu.

Here are some scenarios in which the approval can be stuck:
- Approver has resigned from the company.
- Approver is mistakenly added and doesn't want to approve the change.
- Approver is on leave and a vacation rule hasn't been set up.
- Something unanticipated prevents the workflow from being approved as planned.

To terminate the approval workflow, use the Terminate Workflow action from the Actions list. This action is only
available for the change order assignee.

When you terminate the workflow:

It stops and remains in the Interim Approval or Approval status.

Previous approval notifications for which the approvers haven't responded are removed. Notifications are
removed from: BPM Worklist, worklist information tile in the Product Development work area, and bell
notification.

Note: Except for the Analyst (assignee), all other users need the BPMWorkflowScmAdmin role to cancel,
terminate, and restart change orders. This is regardless of the permissions defined in the additional workflow
controls table. So if you modify the assignee, you must assign the BPMWorkflowScmAdmin role to the new
assignee.

You can modify the list of approvers and restart the workflow. Use the Restart Workflow action from the Actions list.
When you use this action:

- The workflow restarts from the status it was terminated.
New approval notifications are sent.

FAQs About Workflows

What's the difference between One and All in an Approval type
status?

For an Approval type status, on the Header Approval row, you can select One or All for the Response Required From
property.
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One: Only one of the assigned approvers must approve the change order for it to advance.

All: All assigned approvers must approve the change order for it to advance.

How can | learn of problems with the statuses in my change
order's workflow?

Run an audit and obtain the audit report. In the change order, click Actions > Audit, and select a name on the menu.
Then click the Audit Results side tab.

Why is the change order workflow status in the wrong place in the
order sequence?

It might be due to an incorrect sequence number specified in the Manage Change Order Types task (available in the
Product Management offering).

Why did the change order go back to the Open status when
rejected from the Approval status?

The Automatic Demotion Status property on the Approval status was set to Open by the administrator.

Why can't | promote or reschedule a change order | created using
an import map?
Change orders that are generated from item import maps are automatically approved.

However, the change order won’t be promoted or rescheduled if the effective dates of some affected objects in the
change line are less than 30 minutes apart. Ensure that there is a time difference of at least 30 minutes between the
effective dates of the affected objects before promoting or rescheduling the change line.
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11 Relationships

Relationships in ltems and Documents

In an item or a document, you can add related objects for the item you are working on.

When you set a relationship from one business object to another (or manufacturer part or change order), the
association is established in both objects; that is, both objects display the name of the other, related object as a live link.
Click the link to open the related object in its own dynamic tab.

There is no differentiation or hierarchy to relationships.

Use the Add icon + or Actions > Add; the Add Relationships dialog appears. You will only see objects for which you
have privileges. You can click the Refine button to bring the familiar fields for Advanced or Basic searches. The Search
list provides available types of objects that can be searched; the default is Items.

Some details about each item returned on the search appear on mouse hover-over, including the item's Name, Revision,
and Lifecycle Phase. Only the latest revision of any item is returned on the search.

If you select an associated object, the Delete icon X and Actions > Delete are enabled.

Relationships with Business Objects in Other Applications

The administrator may have set up object types from other compatible applications on your system. These external
object types may be listed on the Relationships Search list. For instance, if there are Oracle Cloud Innovation
Management applications configured on your system, object types such as Concepts, Requirements, and Ideas are
available for your search.

Product Development items are specifically available for relationships with Innovation Management business objects. If
a relationship is established between a requirements specification or requirement and an item, and the requirement is
modified in any way, the relationship link to the requirement in the item is then tagged with an indicator with the label
Has changed. (The indicator or icon displays this tool tip.)

A relationship may also be established to an object in another, external application. However, you may find your
privileges to modify such an object are more constrained than objects from Product Development. See your
administrator.

CAD for Cloud Integration

The CAD for Cloud integration enables functional users in the CAD development process to coordinate and relate
designs in Agile PLM to items in Product Development. You can relate a design in Agile PLM to an item in Product
Development with the Publish Workbench tool on the Affected Files tab of a design file change order. You can also
remove the relationship. Once a design object is successfully related to a Product Development item, the relationship
between the two objects is included on the Relationships tab of the design in Agile PLM. It also appears on the item's
Relationships table in Product Development.
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Relationships in Change Orders

You can use the Relationships tab in change orders to track relationships created automatically or manually between
change orders and other objects.

Here are a few examples:

Example 1: Let's say a change order is created from a quality action. Then a relationship is automatically created
between the change order and quality action.

Example 2: Let's say a change order is affected by a quality action. Then you can manually create a relationship between
the change order and quality action.

Note:
From update 23C onward, you can add, update, or delete relationships in canceled change orders. This means
you can also delete a canceled change order after deleting its relationships.

- You can make changes only on the Relationships tab, not on any other tab.

It's not recommended to add new relationships to canceled change orders.

Relationship Type

You can select a Relationship Type (on the Relationships tab) after the relationship is created. Here are the relationship
types:

Fulfills, Fulfilled by, Impacts, Impacted by, Verifies, Verified by, Validates, Validated by, Tracks, and Tracked by, and Split
by import.

Note that Split by import appears selected if the change is created through import and is split during import. A
relationship is automatically created between change orders split during import.

Add Rules to Validate Relationships

Let’s say a quality issue is raised against a defective part, a quality analyst raises a quality action. The defective part
contains a defective structure. So a change order is created from the quality action and a relationship between the
change order and quality action is automatically created.

When the defective part is fixed and released through the change order, the quality action is resolved. This change
order's release indicates that the quality action is validated.

For additional validations, you can create rules.

To add a new rule, click the plus ( +) icon on a change order's Relationships tab. The rule specifies the status that the
change order must be in (or reach) for the quality action to move to an appropriate state. You can change or delete the
rule.

The default rules are: release of the pertinent change order is the only means to validate the related quality actions;
validation of the pertinent quality actions is the only means to close the quality issue.
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Relationship Rules for Changes, Problem Reports, and
Corrective Actions

You can create relationship rules between change orders, change requests, problem reports, and corrective actions.

Use these rules to change the status of one object when the status of a related object is changed to a specific value.
For example, you can create a rule to close a corrective action when a related change order is implemented. Here the
'source’ object on which the rule is defined is the change order, and the 'target' object that the rule should act upon is
the related corrective action.

You create relationship rules using the Add Rule button on the Relationships tab of the source object. Before you create
a rule, the target object must be added as a related object on this tab.

When you add a rule, it lists the source object and then the target object.

Rule Syntax: When <source object name> moves to <status name> status, Move <target object name> to <status
name> status.

Rule example: When ECO 567657 moves to Completed status, move corrective action Keyboard Malfunction to Closed
status.

When the rule is triggered and the target object moves to the specified status, you'll see the action recorded in the
History tab of the target object.

Considerations:

- A relationship can only have one rule. However, this feature supports one-to-one, one-to-many, and many-to-
many relationship rules between the source and target objects.

- You can add or delete rules on both the source and target objects as required.

Note: Users with permissions for the Manage Relationships action in Additional Workflow Controls set to Yes can
add relationship rules.

On the Relationships tab of a change object:
- Click the +icon to create a rule.
- Click the pencil icon to edit the relationship rule.

- Click the X icon to delete the rule.

The rule doesn't trigger if the target object:
hasn't reached the status just before the status specified in the rule.

- is canceled.

Here are some points you must remember while choosing the target and source objects and setting rules:

The source object status can be in any status type except Scheduled.

- The target object status can be in any status type except Scheduled or Completed.
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If a rule fails, you can manually move the target object forward.
- Approval steps won't be skipped.

- The target object moves to the specified status even if you don't have access to edit the target object.
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12 Attachments

Manage Attachments in Items and Change Orders

The Attachments side tab on an item displays a list of documents or graphics or other files that have been attached to
the item. The application tracks changes to attachment file attributes such as name and description.

Attachments on items are subject to change control. You must create a change order to authorize and approve
modifications to attachments. Also, you can't modify an attachment on a released item without a new change order.

You can download item attachments for either first or all structure levels by using the Download action on an item
page.
Here's what you need to know before you download attachments:

- You can download the following attachment types: text, URL, and file. The application manages special
characters and duplicate file names in the attachment title.

- The content of a text attachment is stored in a text file, and the file name is composed of the text attachment
title with the suffix .txt.

If the title information is unavailable or the title contains special characters, then the file name is composed as
TEXT.txt.

- To distinguish multiple instances of the same file name, the application adds a number (#) to the file name. For
example, TEXT.txt, TEXT(1).txt, TEXT(2).txt.

- A similar behavior is available for attachments of type URL. However, the standard file name is URL.txt.

- To distinguish multiple instances of the file name of type DOC, the application adds a number (#). For example,
FILE.doc, FILE(1).doc, FILE(2).doc.

Note: If the download for an item attachment fails, you can use the application severity and Enterprise
Scheduler Service logs to identify attachments with missing file extensions, the file path, and the associated
components.

Attachment Redlines

The modifications to item attachments are called redlines. Redline information for an item is captured in its
Attachments page. The Redline Summary panel displays the attachment modifications. Attachment modifications are
counted in Change Operations.

Change Order Attachments

An attachment on a change order is a document that further explains something about the change order.

You can select Download Attachments from the Actions menu of a change and choose from the following options to
specify which attachments you want to include.

From Affected Objects you can download:
o Redlined: Includes only the redlined (added, created, or modified) attachments of affected objects

o All: Includes all attachments of affected objects
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o None: Excludes attachments of affected objects

- From AML you can download
o Redlined (default option): Includes only redlined (added, created, or modified) manufacturer part
attachments
o All: Includes all the manufacturer part attachments

o None: Excludes manufacturer part attachments
If you select None for both affected objects and AML, the Submit button is disabled.

The Download Attachments action also appears in the change history.

Actions on Attachments in a Change Order

Once the item holds an attachment, the Attachment page actions include:

. CheckIn
« Check Out
- Cancel Checkout

To associate files with items, use the Add icon + or Actions > Add.
If you select a listed attachment, the Delete icon X and Actions > Delete are enabled.

If you find the attachments Add icon + or Actions > Add is disabled, possible reasons are: the item has another, later
revision; or, the item is currently on a change order.

Related Topics
- View Affected Objects and Change Operations

Considerations for Managing Attachments in Items and
Change Orders

Attachments are handled differently in Product Information Management and Product Development work areas.

Here's what you should keep in mind if you're creating and managing attachments in both Product Information
Management and Product Development.

Product Information Management Product Development

Supports item-level and item revision-level Supports only item revision-level attachments.
attachments.

Item and item revision-level attachments  After an item is released, item revision attachments can only be edited by redlining through a change
can be edited through the item, but not order.
through a commercial change order.
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Product Information Management Product Development

Item revision attachments don't flow to the Item revision attachments flow automatically to the next revision, unless deleted.
next revision.

Item images are stored and shared as Item images are stored and shared as item-level attachments.
item-level attachments.

Note: When you add an attachment to an item in Product Development, it will be visible on the item in Product
Information Management only if the item is in a higher lifecycle status than Design. Note that the attachment appears
in Product Information Management as an item revision-level attachment, not as an item-level attachment.

Best Practices

Here are some best practices for managing attachments:

- Use item-level attachments to associate unstructured content and additional details with an item. These
attachments aren't revision-specific; they apply to all revisions of an item.

- Given that these item-level attachments aren't change controlled, always use the actions available on the
Attachments panel from the Product Information Management work area to manage changes to these
attachments.

- Always add attachments to a change order using the +Add button on its Attachments tab to ensure proper
association and auditing. Avoid adding attachments directly from notifications.

FAQs About Attachments

How do | attach files to an item or change?

On an item, document, or change, click the Attachments side tab and then click the Add Attachment icon.

You can optionally associate the file to an attachment category. Attachment categories defined by your administrator
are displayed in the drop-down list for selection. The default attachment category is Miscellaneous.

Related Topics
- Attachment Categories for Changes

- Attachment Categories
- Manage Attachment Security

Why can't | attach files to an item or document?

You need to attach some files to an item or document, but the Add icons on the Attachments tab are grayed out. The
item or document either has another Revision or is on a Change Order currently.
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How can | view redlined attachments for a change order?

On the Edit Change Order page, select Download Attachments from the Actions menu of a change and choose from
the given options to specify which attachments you want to include.

Related Topics
» Manage Attachments in Items and Change Orders

Will attachments | add in Product Development show up in
Product Information Management?

The attachment you add for an item Product Development is visible in Product Information Management only if the
Product Development item is in a lifecycle phase higher than design.

Note that the attachment appears as an item revision attachment in Product Information Management.
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15 Roll Up Costs

Overview of Cost Rollups in Product Development

As part of product design and development, design engineers need estimated costs of a product or its components and
assemblies. During new product development, users build products by using new items and by reusing existing items.

For existing items, costs may have been captured in a costing solution, such as Oracle Cloud Costing. This company can
use costs captured in the costing solution to estimate the costs of the product during product design and development.
For new items, and for existing items that have no set cost, design engineers must provide a high-level estimate of
costs directly to each item.

Note: Documents aren't supported by cost rollups.

Display Costs in Product Development

The following capabilities are supported for cost rollups. Existing or "historical" items in Cloud Costing may provide
costs to Product Development, but the cost rollup functions don't depend on being connected to a deployment of
Costing.

Costs in the Costing solution are based on an inventory organization. To support this, Product Development

can determine what inventory organization to use, to retrieve costs. This option can be disabled if the company
doesn't deploy Costing. By default, the inventory cost organization is the same as the default Product Development
organization, which is the Master Organization.

The Material Cost, Overhead Cost, and Total Cost fields are on the General Information page of an item. On a
structure - a subassembly or top-level assembly - choose Refresh Cost from the list; this retrieves from Costing the
latest costs of all child items and performs the rollup.

Display Costs for a Leaf Item

The Material Cost of an existing item may be retrieved from Costing.

If the item had a cost in Costing, the Material Cost of the item in Product Development is Read Only.

If an item had no cost in Costing, or it's created in Product Development, its Material Cost may be entered, and
it remains an editable field.

For a leaf item, Overhead Cost and Total Cost are always Read Only fields.

Note: The leaf item appears at the end of the entire structure.

Let an item be an assembly, which has a user-entered Overhead Cost; should it become a leaf item, its
Overhead Cost is no longer displayed.
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Display Costs for a Structure

Determining the cost of a structure, or assembly, depends on the completeness of the data on the child items of the
top-level item.

- Material Cost of an assembly is rolled up from the child items. Material Cost is a Read-Only field for an
assembly in PD.

- Overhead Cost for a subassembly or top-level assembly can be entered manually, and it remains an editable
field.

- Let there be aleaf item, which has a user-entered Material Cost; should it become an assembly (top-level or
otherwise), its Material Cost is no longer displayed.

- An assembly's costs may be incomplete because not all of its child items have been assigned costs. To indicate
that the assembly cost is incomplete, a warning icon is displayed next to the Total Cost attribute.

Business and Validation Rules

This topic lists various rules that govern cost rollups in Product Development.

Business Rules of Cost Rollups

This table lists new item request notifications.

Item Type Item Status Item Revision Material Cost Overhead Cost Total Cost
Leaf Not Released (new Initial (Rev A) Editable (unless cost Not editable Not editable
item in preliminary came from Costing)
state)
Leaf Released Latest Editable (unless cost Not editable Not editable
came from Costing)
Leaf Released Not latest Not editable Not editable Not editable
Leaf Pending change order = Any pending rev Editable (unless cost Not editable Not editable
came from Costing)
Assembly Not Released (new Initial (Rev A) Not editable Editable Not editable
item in preliminary
state)
Assembly Released Latest Not editable Editable Not editable
Assembly Released Not latest Not editable Not Editable Not editable
Assembly Pending change order ~ Any pending rev Not editable Editable Not editable

ORACLE
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Validation Rules of Costs

Rules that apply to the expression of costs.

- If the user can enter the cost, it must be a positive value (that is, $0 or greater).

- Users may enter any number of digits after the decimal; however, the application only displays four digits after
the decimal.

FAQs About Roll Up Costs

Can an item's material cost be edited, even if it is retrieved from
costing?
The material cost cannot be overwritten by the user.

However, if the original cost record has been deleted in Costing, that item no longer has a cost, the material cost of the
leaf item can be edited in Product Development. The original material cost will be removed in the Product Development
item.

Can a cost be specific to a revision?

Yes, if you set the cost of an item in Revision A at $10, and create a Revision B and set the cost to $12, the item's rev A
displays as $10 and rev B displays as $12.

Does costing capture revision specific costs of items?

No.

Costing provides costs based on effectivity dates. When Product Development retrieves costs from Costing for a leaf
item, it will use that cost for all revisions of the item, regardless of the item's effectivity date. If a leaf item has a cost of
$15 from Costing, the amount will carry to any future revisions of the same item - as long as it's still a leaf item. If the
cost of the item changes in Costing to $20, the next rollup in Product Development displays the cost of that leaf item as
$20, which would carry to future revisions of the item.

What happens if an item with a material cost becomes a structure?

If this occurred in the same revision, the original material cost is removed and becomes read-only for the structure or
assembly.
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Note that it could still be stored in the schema so that it can be used in a future release. If this occurred in a newer
revision, the material cost remains visible for the previous revision of the item, when it was a leaf item. In the new
revision, the material cost is rolled up from the child items.

Can costs be redlined through a change order?

No, costs can't be redlined through a change order.

What formula is used to calculate total cost?

Material Cost of an assembly is always the rollup of the total costs of its children, including the quantity.

For example, if the total cost of a child item is $10, and there are 5 of these in the structure or assembly, the material
cost of that assembly is $50.

- Total Cost of a leaf item = Material + Overhead (although Overhead will always be 0)

- Total Cost of an assembly = Rolled up Total Costs from the children + Overhead

What happens if the Inventory Cost Organization of an item is
changed to another organization?

When you change the organization of an item, the next time you roll up that item, the cost from the new organization is
used.

If the item, with its original organization, had a cost from Costing, but the new organization doesn't have it, the cost for
the item in Product Development is deleted. This lets you to manually provide a new cost.
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14 Manage Objects from Supplier Portal

View Items on Supplier Portal

As a supplier portal user, you can view the following side tabs on items:

- General Information - the default or cover page of an item.
You can view an item's revision number and the corresponding change order from the Revision list. Note that
canceled item revisions don't appear in the list.

- Attachments - text or graphic files, or URL, with more information about the item.
- Structure - the Bill of Materials for assemblies, products, and other collections of items.

- AML - approved manufacturers list; represents a list of manufacturers, suppliers, or vendors approved for the
purpose of procuring manufactured items.

- Changes - lists changes that the item is on.

- Quality - problem reports, or corrective actions to which this item is added.

- Where Used - displays those item-structures to which the item is added.
History - shows data changes made to audit-enabled item attributes.

Content Presence Indicators

The following content presence indicators help you quickly access item and component details:

- A blueicon indicating the presence of content appears on the item's side tabs. Additionally, when you hover on
the tab that has content, the tooltip displays Has Content.

Note: The General Information tab icon isn't displayed in blue since it always has content.

Blue dot icons on structure component rows indicate the presence of pending changes and quality-related
data. You can click the blue dot to navigate to the corresponding details in the side tab.

For quality objects, the blue dot appears if there is at least one quality issue, quality action, problem report,
or corrective action in any workflow status against any item revision. Note that the object can be pending or
released.

When you click the blue dot on quality objects, only problem reports and corrective actions appear in the
Quality side tab. You can only see and navigate to those objects for which you have access.

Create Problem Reports and Corrective Actions

You can create problem reports and corrective actions from the:

- Create (+) menu on the Overview page in the Quality management work area
- Actions menu of an item in the Product Development work area
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- Actions menu of an item in the Product Information Management work area

You can see that they appear on the Quality tab of items in the Product Development, Product Information
Management, and Quality Management work areas. Remember that the Create Problem Report and Create Corrective
Action options appear on the Actions menu only after you create and save an item.

For suppliers the page reloads with the newly created object.

Note: The newly created problem reports and corrective actions automatically display organization data from the
item.

The workflow of a problem report or corrective action progresses as specified by the statuses defined by the
administrator. For more details, see Set Up Problem Reports and Corrective Actions.

Create 8D Corrective Action.
You can choose to create a corrective action from the following two options in the Type drop-down list:

- Corrective Action — action to mitigate a quality issue and prevent its further occurrence.

- 8D Corrective Actions — action that uses the 8D methodology. An investigative dive to find the cause of a
problem, a solution to fix it and a method to prevent recurrence.

The 8D methodology involves a systematic investigation into the root cause of a problem to prevent recurrence. It uses
a structured, preconfigured template based on 8 disciplines to define the problem, identify the root cause, and run the
corrective and preventative action (CAPA) to prevent recurrence.

Here's a brief description of the eight disciplines:

1. Plan and form team: Create a plan to minimize or mitigate the problem and establish a team of skillful and
knowledgeable people

Define Problem: define and describe the problem

Interim Containment: define and implement containment actions

Determine Root Cause: identify the root cause

Verify Correction: verify and choose the most effective corrective action

Implement Corrective Actions: implement the corrective actions

Prevent Recurrence: implement actions to prevent a recurrence

Recognize Team Effort: acknowledge and congratulate the collective effort of the team.

0Oy U hWON

Note: Although the change type 8D Corrective Actions is predefined, the attribute visibility setting is read-only. The
change type inherits the configuration from its parent change type, Corrective Action.

Create a Corrective Action from a Problem Report

You can also create a corrective action from the Actions menu of a problem report. The corrective action opensina
dynamic tab for editing. For suppliers the page reloads with the newly created object.

While creating a corrective action from a problem report, you can select to copy over the descriptive flexfields,
attachments, relationships, and tasks for the problem report. You can also copy over the affected objects including
descriptive flexfields to the new corrective action. The corrective action is automatically linked to the problem report in
the Relationships tab.
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Related Topics
« Overview of Change Type Setup

« Configure Change Orders
- Understand Change Types

View Changes on Supplier Portal

As a supplier portal user, you can view the changes for which you're granted access.
Here are some of the side tabs available on change orders:

- General Information - the default or cover page of a change order.

The General Information tab displays the cover page details including the trading partner reference attributes
like Customer, Supplier, Manufacturer, and Source. The trading partner reference attributes exposed to the
business user are displayed in the supplier portal.

- Affected Objects - items and structures (including components) that are the subject of the proposed change
or modification. Items can contain problem report, or corrective action.

To view the structure, open the affected object and click the Structure tab.

- Attachments - text or graphic files, or URL, with more information about the change order. As a supplier portal
user, you can only view attachments for which you're assigned permissions.

Content Presence Indicators on Affected Object Structure

Content presence indicators on the structure tab of the affected object provide quick access to changes and quality-
related data.

Here's what you need to know:

Blue dot icons on structure component rows indicate the presence of pending changes and quality-related
data. You can click the blue dot to navigate to the corresponding details in the side tab.

For quality objects, the blue dot appears if there is at least one problem report, or corrective action in any
workflow status against any item revision. Note that the object can be pending or released.

When you click the blue dot on quality objects, only problem reports and corrective actions appear in the
Quiality side tab. You can only see and navigate to those objects for which you have access.

Submit Change Requests from Supplier Portal

If you're a supplier portal user, you can submit change requests to suggest changes to a released item.

You can also initiate the change request workflow by changing the status from Draft to Open. Once the request is open,
the change analyst receives a notification.
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Note:
- The change analyst (or change request assignee) is configured by the administrator as part of the change type
setup.

If you're unable to manage changes from the supplier portal, ensure that you have relevant privileges. For more
information, see the related topics.

Here's how you submit a change request from Supplier Portal:

In Products, click Manage Item Change Requests.

On the Manage Item Change Requests page, click Actions > Create Change Request.
Enter details of the change request, and click Save and Edit.

To change the status of the request from Draft to Open, click Change Status > Open.
Click Save and Close.
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When you receive a notification to approve the status change, enter comments to help the change analyst
review the request.

Related Topics
« Overview of Change Orders and Change Requests

» Configure Supplier Portal Users
» Troubleshoot Access to Objects on Supplier Portal

Publish Change Orders from Supplier Portal

As a supplier portal user, you can publish engineering change orders into an XML report. You can then use the report to
integrate change order data with another application, or for another purpose.

After publishing is complete, the process number including hyperlinks to reports appears in the first 72 hours of report
generation. Later on, only the process number appears.

Here's how you publish a change order from Supplier Portal:

1. In Products, click Manage Item Change Orders.

2. Onthe Manage Item Change Orders page, open an engineering change order that you want to publish. You can
select more than one change order.

3. Click Actions > Publish. Note that you can only publish engineering change orders.

4. Inthe Change Publication Criteria dialog box, select the entities you want to publish and click Publish.

A process ID is generated for each change order. You can also monitor the publication status from the Manage
Item Change Orders page.

Here are some additional details about entities:

o The Include attachment files check box is enabled only if you select the change attachment entity.
Select this check box to include the attachment files (digital assets) along with the attachment metadata
when you publish.

o By default, the Change general information entity is always selected for publishing and you can't
change this setting.
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15 Analyze Objects with OTBI

Why Use OTBI Reports

Use OTBI (Oracle Transactional Business Intelligence) reports to view embedded real-time analytics, reports, and
dashboards based on real-time transactional data in Oracle Fusion applications.

To access reports and analytics from the Product Development work area, click the Reports and Analytics side tab.

Related Topics
« Overview of Transactional Business Intelligence

Use Predefined OTBI Dashboards for Changes and Items

With additional dashboards in OTBI (Oracle Transactional Business Intelligence), you can view analyses for PLM objects.

Navigate to Oracle Transactional Business Intelligence > Dashboards > Supply Chain Management > Change
Orders Dashboard or PLM Details Dashboard.

Use the Change Orders dashboard to analyze the count, cycle time, and aging metrics of change orders, change
requests, problem reports and corrective actions and drill-down to view detailed reports. By default, the dashboard

will display data from the current year and the previous year. You can view the status, and the remaining or pending
approvers to approve the change orders using change order approval reports. Use the PLM Details dashboard to search
for items using various attribute filters. Use the link in the dialog box with available reports, set up by the administrator,
to view the OTBI report results page.

Publish Items for Analysis in OTBI

To make data available for reports, you must first publish the data for analysis in OTBI (Oracle Transactional Business
Intelligence). You can publish the item structure and where-used data.

Here's how:
« On the item page, click Actions > View Reports > Publish.

Or

- On the item search results page, select the items you want to publish. Then click Actions > Publish for
Analysis.

The analysis on items and structures provides critical decision-making information.
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Note that you must have either of these roles:

Product Manager (ORA_EGP_PRODUCT_MANAGER_JOB)
Product Design Engineer (ORA_ACD_PRODUCT_DESIGN_ENGINEER_JOB).
Note: To see the descriptive flexfields in OTBI, you must run the scheduled process - Import Oracle Fusion Data

Extensions for Transactional Business Intelligence and to populate data in Structures and Components and Where
Used subject areas, you must run the scheduled process - Run Scheduled Process for Populating Subject Areas.

Related Topics
» Overview of Creation and Administration of SCM Analytics and Reports

« SCM Subject Aeas in Oracle Transactional Business Intelligence
- How You Create and Edit Reports

FAQs About OTBI

How can | add the publish date and time in a report?

Navigate to Tools > Reports and Analytics > Browse Catalog. Open a report and expand Views in the side panel.
In the Compound Layout page, select the Title attribute and click Edit.
- Select Display Date and Time from the Started Time drop-down list and click Done.

The report will display the last publish date and time.
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16 New Item Requests

Overview of New ltem Requests

In Product Development, items are usually created with create dialog or various add item features on items, structures,
and change orders.

There's a more formal process of item creation called the New Item Request process. The administrator can establish a
Product Development item class that requires the new item request process to be followed.

In the new item request process, a new item is validated and approved before it's made available to enrichment
processes and structure-building in Product Development. The validation steps take place in the Product Information
Management work area.

A new item request may be appropriate for a product that will go through the complete manufacturing or
commercialization phases. A less formal process may be appropriate for a more preliminary, design phase of product
innovation.

Your enterprise may use either the formal new item request process, or the informal processes for the development of
new items and structures.

Related Topics
« Create New Item Requests

« When can items be added to a new item request?
« Set Up New Item Requests

New [tem Request Process

The formal process of item or structure creation requires the new object to go through a workflow. The item creation
may be initiated in Product Development, but it passes over to Product Information Management for the analysis and
approval process.

When a development item is created in Product Development, and it's going to be oriented through new item request,
a product manager or item analyst is notified of the item. When the new item request process is triggered, the item is
routed to assignees, who are informed what needs to be considered based on the item class setup.

The stages of the workflow are:
- Open - submitted
- Definition - when the assignees respond
- Scheduled
- Completed

The item is routed for approval, only after it has passed through the Completed status.
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For an item that's undergoing the new item request process, the Approval Status attribute - on the General
Information tab - displays the new item request number along with its approval status. This lets a Product
Development user identify those items that are engaged in the new item request process.
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